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About this document
This document guides you through the pre-commissioning and commissioning
procedures for the system equipment. This document covers commissioning
for initial installations only. If you are performing an upgrade or a
transformation, refer to the appropriate AccessNode CAP.

Audience
This document is targeted for the maintenance technicians and experienced
installers from Nortel Networks or a telephone operating company who
perform system lineup and test (SLAT) operations.

How to use this document
This document contains procedures that are not required for commissioning
some systems. Use the task list in Chapter 1 to determine if you need to
perform any procedures in this document.

Warnings and safety precautions
This section has the samples of the danger and caution warnings for proper
handling and operation of equipment.

To avoid injury, follow all danger warnings provided with this product, as well
as safety procedures established by your company.

To avoid damage to equipment or service interruptions, follow all caution
warnings provided with this product, as well as procedures established by your
company.

Samples of danger and caution warnings follow.

DANGER
Risk of personal injury
A danger warning informs the reader of a risk of personal
injury.
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OPC user interfaces and conventions used in procedures
The OPC procedures in this document are based on the character mode
terminal (CMT), but can also be performed from a graphics terminal. However,
to do this you must substitute the graphic equivalents for the CMT keystrokes
that are provided in the procedures.

CAUTION
Risk of service interruption or equipment damage
A caution warning informs the reader of a risk of service
interruption or equipment damage.

DANGER
Risk of electric shock
This warning advises you of a possible electrical hazard.
When you see this warning, proceed with care, to avoid
personal injury.
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References in this document
This document refers to the following documentation:
Separately bound documents

• Modular Business Package Installation Manual,323-3001-206
Engineering, Configuration, and Ordering Guide, Volume 1

• Mapper Layouts Planning Guide, 323-3001-154
Commissioning and Testing, Volume 3A

• Setting Up Your System: VTBM, 323-3001-230

• Setting Up Your System: DFA, 323-3001-235

• Setting Up Your System: Point to Point, 323-3001-240

• Setting Up Your System: Single Ended, 323-3001-245
Operations, Administration, and Provisioning, Volume 4A

• Network Element User Interface Description, 323-3001-300

• OPC User Interface Description, 323-3001-301

• System Administration Procedures, 323-3001-302

• Data Administration Procedures, 323-3001-304
Operations, Administration, and Provisioning, Volume 4B

• Line Card Provisioning Procedures, 323-3001-315
Operations, Administration, and Provisioning, Volume 4C

• Addition of AN Nodes in a VTBM Ring

Maintenance, Volume 5C

• Network Surveillance Procedures, 323-3001-510
Other Documents

• Network Manager User Guide, 323-4001-050
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Overview of optional commissioning 1-
This chapter describes the optional commissioning tasks that you can preform
after you set up the system using one of the four following guides:

The process of commissioning a new network element (NE) in an existing
system is described inAddition of AN Nodes in a VTBM Ring, in Operations,
Administration, and Provisioning, in Volume 4C.

The following table lists procedures that may help you finalize commissioning
depending on the equipment you have.

Equipment cautions and warnings
This section has the warnings and precautions for personal safety and for
proper handling and operation of equipment.

Configuration Configuration Description

• VTBM ring system
323-3001-230

This is a fiber-fed system consisting of up to sixteen
network elements connected in a bidirectional
line-switched ring (BLSR), in an AccessNode OPC span
of control.

• Point-to-point system
323-3001-240

This is a fiber-fed system consisting of a fiber central
office terminal (FCOT) and a remote fiber terminal (RFT),
in an AccessNode OPC span of control.

• Single-ended system
323-3001-245

This is a fiber-fed system consisting of one RFT,
connected to a local digital switch using a SONET
transport network (such as an OC-12 TransportNode
ring), in an AccessNode OPC span of control.

• DS1-fed (DFA) system
323-3001-235

This is a copper-fed system consisting of one RFT,
connected to a local digital switch using DS1 facilities, in
an AccessNode OPC span of control.

If you have this equipment then see these chapters

MPP 2

OPC 3, 4, and 5



1-2 Overview of optional commissioning

AccessNode Vol 3B 323-3001-220 Issue 2.0

Radio-frequency emissions notice
The following regulatory notice applies to the equipment:

Note:This equipment has been tested and found to comply with the limits
for a Class A digital device, pursuant to Part 15 of the FCC Rules. These
limits are designed to provide reasonable protection against harmful
interference when operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a
residential area may cause harmful interference, in which case the user will
be required to correct the interference at his own expense.

Static electricity
It is usual for static electrical charges to build up on the body if a person walks
a short distance. This buildup of static electricity is sufficient to damage some
circuit packs if it is not properly discharged first. Circuit packs that are
sensitive to damage by static electricity should be packaged in antistatic
material. The following precautions are recommended.

Handling circuit packs
Units that are sensitive to static electricity are marked in their antistatic
shipping bags with the following symbol:

To avoid static electrical damage when handling circuit packs, follow these
rules:

• Do not remove circuit packs from their antistatic packages unless you are
using antistatic protection, such as wearing an antistatic wrist strap. The
wrist strap is attached to a long cord, which must terminate at a good

CAUTION
Risk of equipment damage
Wear a grounded antistatic wrist strap or equivalent
protection when handling circuit packs, to avoid damaging
electronic parts.

ATTENTION
OBSERVER LES PRECAUTIONS
POUR LA MANIPULATION DES
DISPOSITIFS SENSIBLES AUX
CHARGES STATIQUES

ATTENTION
OBSERVE PRECAUTIONS
FOR HANDLING
ELECTROSTATIC
SENSITIVE DEVICES
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ground source, so that static buildup is harmlessly discharged. Alternative
antistatic methods include conductive carpet, conductive shoes, or heel
grounders. Use the equipment recommended by your company.

• Handle each circuit pack by the faceplate or stiffener. Do not touch
electrical connections, pins, or soldered surfaces.

Protect optical connectors by covering them with clean dust caps.

Storing and transporting circuit packs
When storing and transporting circuit packs, follow these rules:

• Never transport, stack, or store circuit packs without first replacing them in
their antistatic material and original shipping package. This avoids
physical damage and accumulation of dirt or dust on goldplated contacts.
Be careful not to damage any parts when inserting the circuit pack into its
packaging.

• Avoid storage in areas where the relative humidity can exceed 95% and
where the temperature can exceed 70° C, because boards can warp or
corrode.

Laser radiation
The equipment and associated optical test sets use laser sources that emit light
energy into fiber cables. This energy is within the red (visible) and infrared
(invisible) regions of the electromagnetic spectrum.

Laser products are subject to federal and state or provincial regulations, and
local practices. Regulation 21 CFR 1040 of the U.S. Bureau of Radiological
Health requires manufacturers to certify each laser product as Class I, II, III,
or IV, depending upon the characteristics of the laser radiation emitted. In
terms of health and safety, Class I products present the least hazard (none at
all), while Class IV products present the greatest hazard.

Although Nortel Networks optical products have a Class I certification,
hazardous exposure to laser radiation could occur when fibers that
interconnect system components are disconnected or broken. Certain
procedures carried out during testing require the handling of optical fibers

DANGER
Risk of eye damage
At all times when handling optical fibers, follow the safety
procedures recommended by your company.

Read and follow the precautions below, to decrease the risk
of exposure to laser radiation.
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without dust caps, and therefore increase the risk of exposure. Exposure to
either visible or invisible laser light could cause eye damage under certain
conditions.

Equipment warning label
The equipment label is located in the top left corner of the back cover. It reads
as follows:

To be installed only in restricted access areas (dedicated
equipment rooms, equipment closets, or the like) in accordance
with articles 110-16, 110-17, and 110-18 of the National
Electrical Code, ANSI/NFPA No. 70.

Avoid direct exposure to
beam. Invisible light can
blind. Keep all optical
connectors capped.

The caution label at the right appears on the
optical interface card, near the optical connector,
and should be complied with.

Caution
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2-1

Installing MPP rectifiers 2-
Use the procedures in this chapter to prepare a network element (NE) for
commissioning. This chapter lists equipment requirements for site testing and
describes the portable operations controller (OPC).

How to use this chapter
Before proceeding with this chapter, refer to the flowcharts and task lists in
Chapter 1. These flowcharts and task lists identify the procedure sequence for
commissioning a new system. If you cannot successfully complete any of
these procedures, contact your next level of support.

Chapter topics
The following table lists the topics in this chapter. These topics are procedures
that guide you through preparing an NE for commissioning.

Topics See

Installing the MPP rectifiers page 2-3

Verifying the MPP rectifiers page 2-8

Verifying the NT6C14JA (MPP) dc distribution shelf page 2-14
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Figure 2-1
Modular power package (MPP) configuration
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Procedure 2-1
Installing the MPP rectifiers

Use this procedure to install the NT5C06CA rectifiers in the NT5C10CC-1
rectifier shelf (or shelves) of the modular power package (MPP) cabinet. The
MPP cabinet provides dc power to the modular business package (MBP)
system. The NT5C06CA rectifier is shown in Figure 2-3 on page 2-7.

Requirements
Do the following before starting this procedure:

• Make sure the modular power package (MPP) is installed and cabled as
documented inModular Business Package Installation Manual,
323-3001-206.

• Ensure that power connections are in one of the following conditions:

—continued—

DANGER
Risk of injury or damage
Read the warnings and precautions in Chapter 1 to minimize
any risk to personnel and equipment.

Where the But the

feeds (commercial ac power) to the MPP
are installed

circuit breakers (fuses) at the
commercial ac power panel are open
(removed)

−48 V dc power feeds from the MPP to
the breaker interface panel (BIP) in the
MBP master cabinet are installed

circuit breakers at the MPP and BIP
are open

battery string (if equipped) is installed
and connected to the MPP battery
terminal blocks

battery string circuit breakers (fuses)
are open (removed)

SPG terminal on the back of the MPP dc
distribution shelf is connected to building
principle ground (BPG) or building single
point ground (SPG)
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Procedure 2-1 (continued)
Installing the MPP rectifiers

Tools and materials
You need the following tools and materials:

• one small flat-head (slotted) screwdriver 0.10 inch wide

Action

Step Action

1 Make sure the following connections are correct and tight:

—continued—

From the To the

commercial ac power panel MPP rectifier shelves

battery string MPP dc distribution shelf

MBP cabinet(s) MPP dc distribution shelf

MPP dc distribution shelf MPP rectifier shelves

MPP framework BPG (or SPG)

single point ground terminal on the back of
the MPP dc distribution shelf

BPG (or SPG)
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Procedure 2-1 (continued)
Installing the MPP rectifiers

Step Action

2 Release the clamping bar on the rectifier shelf by loosening the two captive
screws at the front of the shelf. Swing the clamping bar down, as shown
below.

3 Remove the blank panel from the selected rectifier position as explained in
steps 3a through 3d below. The shelf with blank panels in place is shown on
Figure 2-2 on page 2-6.

a. Place a finger in the blank panel hole and lift up the panel, dislodging the
lower tabs from the bottom of the shelf.

b. Pull the bottom of the panel out until it clears the shelf bottom.

c. Lower the panel to dislodge the upper tabs from the shelf top.

d. Store the blank panel under the rectifier shelf.

4 Verify that the circuit breakers of the rectifier are in the off (down) position, as
shown in Figure 2-3 on page 2-7.

5 Slide each rectifier into the shelf, resting it on top of the stored blank panel.

6 Repeat steps 3 through 5 to install each rectifier.

7 Swing the clamping bar upward and tighten the captive screws.

8 Note on the Commissioning Results Form that you have completed this
procedure.

—continued—

Captive
screw

Clamping
bar

Swing clamping bar
downward to open Captive

screw
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Procedure 2-1 (continued)
Installing the MPP rectifiers

Figure 2-2
NT5C10CC-1 rectifier shelf, with and without blank panels
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Front view
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Procedure 2-1 (continued)
Installing the MPP rectifiers

Figure 2-3
NT5C06CA rectifier, front view
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Procedure 2-2
Verifying the MPP rectifiers

Use this procedure to adjust and verify the NT5C06CA rectifiers in the
NT5C10CC-1 rectifier shelf (or shelves) of the modular power package (MPP)
cabinet. The rectifier provides dc power to the modular business package
(MBP) system. The NT5C06CA rectifier is shown in Figure 2-3 on page 2-7.

Requirements
Before starting this procedure, make sure:

• you have obtained the recommended settings from your battery vendor or
power engineer for the following parameters:

— float voltage (FLT)

— equalize voltage (EQL)

— high voltage shutdown (HVSD)

Note: Voltage setting requirements are subject to change without notice.
Consult the battery manufacturer’s documentation for the latest voltage
setting for your system.

• the rectifiers are installed. The dc and ac circuit breakers (on the rectifier
faceplate) are in the off position.

—continued—

DANGER
Risk of injury or damage
Read the warnings and precautions in Chapter 1 to minimize
any risk to personnel and equipment.
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Procedure 2-2 (continued)
Verifying the MPP rectifiers

• the NT6C14JA dc distribution shelf (with NT6C14PC controller and
digital volt/ammeter) is installed.

• the power connections are in the following condition:

Tools and materials
You need the following equipment:

• one digital multimeter, for example, Fluke 85

• one small flat-head (slotted) screwdriver, to adjust potentiometers

—continued—

Where the But the

commercial ac power feeds to the MPP
are installed

circuit breakers (fuses) at the
commercial ac power panel are open
(removed)

−48 V dc power feeds from the MPP to
the breaker interface panel (BIP) in the
MBP master cabinet are installed

circuit breakers at the MPP rectifiers
and dc distribution shelf and MBP BIP
are open

battery string (if equipped) is installed
and connected to the MPP battery
terminal blocks

battery string circuit breakers (fuses)
are open (removed)
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Procedure 2-2 (continued)
Verifying the MPP rectifiers

Action

Step Action

1 Locate the EQL switch on the dc distribution shelf. Move the EQL switch to
the off position.

Note: This switch must remain off throughout this procedure.

2 Move the associated SENSE DIP switches on all rectifiers to the off position.
The SENSE DIP switches are located on the faceplate of the dc distribution
shelf.

Note: Off corresponds to local sensing mode. On corresponds to remote
sensing mode. The SENSE DIP switch numbers and associated rectifier
positions are given in the following table. Rectifier shelf 1 is the upper shelf.
Rectifiers are numbered from right to left, as shown in Figure 2-2 on
page 2-6.

3 At the commercial ac power panel, insert the fuse or switch the main circuit
breaker to the on position for the rectifier shelf under test.

4 Switch the ac circuit breaker on the rectifier under test to the on position. The
NT5C06CA rectifier is shown in Figure 2-3 on page 2-7.

When the ac circuit breaker is switched on, the rectifier ON/RFA LED comes
on red. Then, after 15 seconds, the LED turns green.

—continued—

SENSE DIP
switch number

Rectifier
shelf

Rectifier
designation

1 1 RECT1

2 1 RECT2

3 1 RECT3

4 2 RECT4

If the Then

ON/RFA LED on the rectifier
under test stays red and does
not turn green

Note: MPP25 rectifier ON/RFA
LED is red for current < 0.1 A.

• turn off the ac breaker for the affected
rectifier

• verify that the inrush fuse (F1) and the
220 V ac supply are OK

inrush fuse (F1) and the
220 V ac supply are OK

replace the rectifier with a new one
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Procedure 2-2 (continued)
Verifying the MPP rectifiers

Step Action

5 Switch the dc circuit breaker on the rectifier under test to the on position.

6 Connect the digital multimeter across the OUTPUT V+ and V−test points on
the rectifier being tested.

7 While monitoring the dc voltage on the multimeter display, slowly adjust the
FLT potentiometer clockwise to increase the float voltage. Stop adjusting
when one of the following first occurs:

• the high voltage shutdown (HVSD) occurs

• the multimeter display indicates −56.0 V dc

• the maximum voltage adjustment is reached with the FLT potentiometer

When HVSD occurs, the ON/RFA LED turns red. HVSD should occur at
−56.0 ± 0.1 V dc. Shutdown causes the internal rectifier protection circuit to
inhibit rectifier output; circuit breakers do not trip.

—continued—

CAUTION
Risk of equipment damage
If the rectifier voltage is adjusted higher than
-56.0 V dc, the powered equipment can be damaged. For
example, a rectifier voltage of -58.0 V dc can damage that
equipment.

If Then

the −56.0 V dc level cannot be
reached by adjusting the FLT
potentiometer

boost the rectifier output voltage by
adjusting the EQL potentiometer clockwise
while holding the EQL/FLT switch at EQL
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Procedure 2-2 (continued)
Verifying the MPP rectifiers

Step Action

8 Proceed according to the result of step 7:

9 Slowly adjust the FLT potentiometer to set the float voltage to the required
value (clockwise to increase, counterclockwise to decrease).

10 Hold the EQL/FLT momentary switch to the EQL position.

11 Measure the EQL voltage level across the OUTPUT V+ and V−test points of
the rectifier.

12 Slowly adjust the EQL potentiometer to set the equalize voltage to the
required value (clockwise to increase, counterclockwise to decrease).

13 Release the EQL/FLT switch to the FLT position.

14 Switch the dc and ac circuit breakers to the off position.

—continued—

If Then

shutdown occurred at −56.0 V
dc, as desired

Use the digital multimeter to measure the
dc voltage across the OUTPUT V+ and V-
test points on the faceplate of the rectifier.

shutdown occurred before
reaching −56.0 V dc

• increase the HVSD threshold by turning
the HVSD potentiometer fully clockwise

• go to step 7

−56.0 V dc was reached and
no shutdown occurred

• reduce the HVSD threshold by turning
the HVSD potentiometer slowly
counterclockwise until the rectifier shuts
down

• verify the −56.0 V dc shutdown by
reducing the rectifier voltage
(turn the FLT potentiometer one turn
counterclockwise)

• go to step 7

CAUTION
Risk of equipment damage
If the rectifier voltage is adjusted higher than
-56.0 V dc, the powered equipment can be damaged. For
example, a rectifier voltage of -58.0 V dc can damage that
equipment.
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Procedure 2-2 (continued)
Verifying the MPP rectifiers

Step Action

15 Repeat steps 3 to 14 for each installed rectifier.

16 Make the following adjustments:

When all installed rectifiers are set to the same voltage, the ON/RFA LEDs
turn green on the installed rectifiers.

17 Check all rectifiers for the ON/RFA LED conditions.

Note: Best adjustment results are obtained when the system circuit packs
are powered up. It is recommended to repeat the load-sharing portion of this
procedure (steps 17 and 18), after the load is connected.

18 Record the voltage setting limits and store the information for future
reference.

19 Note on the Commissioning Results Form that you have completed this
procedure.

Table 2-1
Sample rectifier and power plant voltage settings

—end—

Switch On the To the

SENSE DIP switch dc distribution shelf on position

ac circuit breaker rectifier on position

dc circuit breaker rectifier on position

If Then

the ON/RFA LED is
red

the rectifier output current is too low. The following
adjustment must be made:

• slowly adjust its FLT potentiometer slightly clockwise
until the ON/RFA LED turns green

Battery
Manufacturer

Float Equalize HVSD LVA LVD

Gates 6V –55.0 + 0.1 –55.5 + 0.1 –56.0 + 0.1 –47.0 + 0.1 –43.0 + 0.1

Eagle Picher 12V –54.7 + 0.1 –55.4 + 0.1 –56.0 + 0.1 –47.0 + 0.1 –43.0 + 0.1

Yuasa 12V –54.0 + 0.1 –54.0 + 0.1 –56.0 + 0.1 –47.0 + 0.1 –43.0 + 0.1
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Procedure 2-3
Verifying the NT6C14JA (MPP) dc distribution shelf

Use this procedure to adjust and verify operation of the NT6C14JA dc
distribution shelf (with NT6C14PC controller and digital volt/ammeter)
installed in the modular power package (MPP) cabinet.

Requirements

Before starting this procedure, make sure:

• the rectifiers are adjusted, verified, and remain in the powerup condition
(all rectifier circuit breakers are on)

• the dc distribution shelf circuit breakers are in the off position.

• you obtain the required settings from your battery vendor or power
engineer for the following list:

— low voltage alarm (LVA),

— low voltage disconnect (LVD)

— low voltage reconnect (LVR)

Tools and materials
You need the following tools and materials:

• one digital multimeter, for example, Fluke 85

• one small flat-head (slotted) screwdriver 0.10 inch wide

—continued—

DANGER
Risk of injury or damage
Read the warnings and precautions in Chapter 1 to minimize
any risk to personnel and equipment.
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Procedure 2-3 (continued)
Verifying the NT6C14JA (MPP) dc distribution shelf

Action

Step Action

1 Turn on all the circuit breakers on the NT6C14JA dc distribution shelf.

The fuse alarm (FA) indicator is extinguished.

2 Turn off circuit breaker CB1 on the NT6C14JA dc distribution shelf.

The fuse alarm (FA) indicator lights up.

3 Turn on circuit breaker CB1 on the NT6C14JA dc distribution shelf.

The fuse alarm (FA) indicator is off.

4 Repeat steps 2 to 3 for each circuit breaker on the NT6C14JA dc distribution
shelf.

The FA alarm appears, then disappears, as each breaker is cycled.

5 Turn all NT6C14JA dc distribution breakers back to the off position.

6 Turn the EQL switch (on the NT6C14JA dc distribution shelf) to the on
position.

The EQL yellow LED next to the switch illuminates. The voltage displayed on
the digital meter (on the faceplate of the dc distribution shelf) corresponds to
(but may not equal) the equalize voltage set on the rectifiers in
Procedure 2-3).

7 Turn the EQL switch to the off position.

The voltage returns to the float level.

8 Turn the dc and ac breakers on rectifier 1 to the off position.

The RFA MIN yellow LED (on the dc distribution shelf) turns on, indicating a
minor rectifier failure alarm.

9 Turn the dc and ac breakers on rectifier 1 to the on position.

The RFA MIN yellow LED turns off.

10 Repeat steps 8 and 9 for each rectifier.

11 Turn the dc and ac breakers on two rectifiers to the off position.

The RFA MAJ red LED turns on, indicating a major rectifier failure alarm.

12 Turn the dc and ac breakers on one rectifier to the on position.

The RFA MAJ red LED turns off, and the RFA MIN yellow LED turns on.

13 Turn the dc breaker on the second rectifier to the on position.

The RFA MIN yellow LED turns off.

—continued—



2-16 Installing MPP rectifiers

AccessNode Vol 3B 323-3001-220 Issue 2.0

Procedure 2-3 (continued)
Verifying the NT6C14JA (MPP) dc distribution shelf

Step Action

14 Set the (LVD) NORM/BYP switch to the BYP position.

The TST BYP LED turns on.

15 Connect the digital multimeter, set to read volts dc, at the test jacks on the
faceplate of the NT6C14JA dc distribution shelf.

16 Slowly turn the TST ADJ potentiometer counterclockwise and monitor the
digital multimeter to determine the low voltage alarm (LVA) threshold.

The LVD ALM LED should light up when reaching −47.0 ± 0.2 V dc.

—continued—

If the LVD ALM LED Then

is on before reaching
−47.0 ± 0.2 V dc

• continue to turn the TST ADJ
potentiometer counterclockwise until the
voltage reading reaches −47.0 V dc

• slowly turn the LVD ADJ potentiometer
clockwise until the LVD ALM LED
extinguishes

• slowly turn the LVD ADJ potentiometer
counterclockwise until the LVD ALM LED
is on

does not come on before
reaching −47.0 ± 0.2 V dc

• use the TST ADJ potentiometer to set the
voltage reading to -47.0 V dc

• slowly turn the LVD ADJ potentiometer
clockwise until the LVD ALM LED comes
on
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Procedure 2-3 (continued)
Verifying the NT6C14JA (MPP) dc distribution shelf

Step Action

17 Slowly turn the TEST ADJ potentiometer counterclockwise and monitor the
digital multimeter to determine the LVD threshold.

The LVD ALM LED should light up when reaching −43.0 ± 0.2 V dc.

18 Slowly turn the TEST ADJ potentiometer clockwise until the LVD ALM LED
extinguishes at −47.0 ± 0.2 V dc.

19 Continue to adjust the TEST ADJ potentiometer clockwise until the LVD ALM
LED extinguishes.

20 If the LVD LED remains on, slowly adjust the TEST ADJ potentiometer to
−50.5 V dc.

21 Slowly turn the low voltage reconnect (LVR) potentiometer counterclockwise
or clockwise until the LVD ALM LED extinguishes.

22 Set the LVD NORMAL/BYP switch to the NORMAL position.

23 Verify that the float voltage is set to the battery manufacturer's requirement.

—continued—

If the LVD ALM LED Then

is on before reaching
−43.0 ± 0.2 V dc

• continue to turn the TST ADJ
potentiometer counterclockwise until the
voltage reading reaches −43.0 V dc

• slowly turn the LVD ADJ potentiometer
clockwise until the LVD ALM LED
extinguishes

• slowly turn the LVD ADJ potentiometer
counterclockwise until the LVD ALM LED
comes on

does not come on before
reaching −43.0 ± 0.2 V dc

• use the TST ADJ potentiometer to set the
voltage reading to −43.0 V dc

• slowly turn the LVD ADJ potentiometer
clockwise until the LVD ALM LED comes
on

CAUTION
Risk of service outage
If you switch the BYPASS/NORMAL switch back to the
NORMAL position before the LVD and LVR potentiometer
adjustments are fully verified, you can cause a loss of
power to the load.
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Procedure 2-3 (continued)
Verifying the NT6C14JA (MPP) dc distribution shelf

Step Action

24 The MBP/MPP does not include a backup battery string but allows
connection to an external battery string, if the customer has provided one.

25 Make sure all circuit breakers on the rectifiers are on.

26 Make sure all circuit breakers on the dc distribution shelf are off.

27 If the optional MPP blower is installed, move CB6 to the on position.

When two rectifier shelves are installed, the MPP must be equipped with a
cooling unit. If equipped, the MPP blowers are now operating.

If the blowers fail to operate, make sure the blower circuit breaker 1 (on the
blower unit) is in the on position. Access the blower circuit breaker from the
front of the MPP cabinet, in the pedestal with the front grille removed.

28 Record all measurements and results for future reference.

—end—

CAUTION
Risk of equipment damage
If the rectifier voltage is adjusted higher than
-56.0 V dc, the powered equipment can be damaged. For
example, a rectifier voltage of -58.0 V dc can damage that
equipment.

If Then

an external battery string is installed • charge the battery string according
to the manufacturer's recommended
procedures

• verify the battery string according to
the manufacturer's recommended
procedures

If Then verify the following

any battery operation fails • continuity of the cables from the
MPP to the battery string

• any control equipment and wiring at
the battery string, according to the
manufacturer's product
documentation
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3-1

Installing OPC software on a remote
OPC 3-

This chapter contains procedures for using the Remote OPC Software
Installation tool. The Remote OPC Software Installation tool is used to transfer
operations controller (OPC) software loads from the local OPC tape drive to
the remote OPC (that is, the backup OPC). Installing OPC software on the
remote OPC disk can take up to two hours to complete, depending on the
amount of traffic between the local and remote OPC. This tool does not
transfer loads from the local disk to a remote disk.

To transfer loads using this tool, you select specific loads (called packages) and
group them into a single set to be installed (called an installation). This
installation is listed in the main window. Also on the main window are buttons
that allow you to create an installation and install it on a remote OPC.

Only one active OPC software release at a time is kept on the OPC disk. When
a software release is upgraded, the existing active OPC software is deleted
from the remote OPC disk before the new software is installed. The new
release is then installed on the remote OPC using Procedure 3-1 on page 3-3.

Under normal conditions, you do not use the Remote OPC Software
Installation tool by itself. It is most often used in combination with other tools
to upgrade an OPC software release. The complete set of software upgrade
procedures differs for each system. For the software upgrade procedures for
your system, see your Nortel Networks representative for the software upgrade
change application procedure (CAP).
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Note 1:Use the Remote OPC Software Installation tool only when local
OPC software package installation is not possible (that is, whenever the
local OPC does not have a tape drive). Perform regular OPC software
upgrades using the Network Upgrade Manager.

Note 2:If you plan to use the Central User Administration (CUA) tool as
part of the installation, seeSystem Administration Procedures,
323-3001-302, inOperations, Administration, and Provisioning, Volume
4A, for directions to modify the tool.

For further information on the Remote OPC Software Installation tool, see
OPC User Interface Description, 323-3001-301, inOperations,
Administration, and Provisioning, Volume 4A.

Handling and storing digital audio tapes
Keep digital audio tapes (DATs) away from moisture, extreme hot and cold
temperatures, and magnetic fields and devices.

When handling DATs around equipment, note that electrostatic-sensitive
devices can be damaged by electrostatic discharge. Always ground yourself
before handling the tape.

General requirements
To install OPC software on a remote OPC, the following requirements must be
met.

• an OPC software release must be installed on the local OPC disk

• the local OPC must be equipped with a tape drive and a local disk

• remote OPCs must be recognized by the local OPC

Chapter task list
This chapter includes the following tasks. They can be performed at any time
and in any order.

If you cannot successfully complete these procedures, contact your next level
of support.

Procedure Task See

3-1 Installing OPC software on a remote OPC page 3-3

3-2 Canceling an installation page 3-7

3-3 Identifying the software release on a remote OPC page 3-9

3-4 Identifying the software release on the local OPC tape page 3-11

3-5 Viewing the Installation History dialog page 3-13
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Procedure 3-1
Installing OPC software on a remote OPC

Use this procedure to transfer an operations controller (OPC) software
package from the tape drive of the local OPC and to install the package on one
or more remote OPC disks. This procedure can take up to two hours to
complete.

Note 1:If you log out of the local OPC during an installation operation, the
operation is canceled.

Note 2:During an installation operation, the active software release is
removed from the remote OPC. To avoid disrupting current processes on
the remote OPC, inform all OPC users about the transfer and which OPCs
are involved.

Requirements
To perform this procedure, you must:

• insert the appropriate tape in the local OPC tape drive

• have a userID and password that allow you access to the Remote OPC
Software Installation tool

• read the command conventions for the interface type you are using (CMT
or graphical) inOPC User Interface Description, 323-3001-301, in
Operations, Administration, and Provisioning, Volume 4A

Action

Step Action

1 Log in to the OPC and open the Remote OPC Software Installation tool.

Messages appear, indicating that the software loads will be extracted from the
tape in the tape drive.

2 When you are prompted to continue with the installation, enter y, then press
Return .

The main window of the Remote OPC Software Installation tool appears.
—continued—

CAUTION
Electrostatic sensitive devices
Electrostatic sensitive devices can be damaged by
electrostatic discharge. Always ground yourself before
handling the tape.
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Procedure 3-1 (continued)
Installing OPC software on a remote OPC

Step Action

3 Select the Setup button by pressing Ctrl_A (or Keypad 0).

The Installation Setup dialog appears.

4 Tab to the Query Tape button, then press Ctrl_A (or Keypad 0).

The tape in the local OPC tape drive is read and its contents appear in the
Release field and the Packages list.

5 Tab to the Destination OPCs list.

6 Move to the OPC where you want to install a package, then press Ctrl_A (or
Keypad 0).

To select additional OPCs, move to the OPC you want, then press Ctrl_Y.

The destination OPCs are highlighted.

7 Tab to the Packages list.

8 Move to the software package you want to install, then press Ctrl_A (or
Keypad 0).

To select additional packages, move to the package you want, then press
Ctrl_Y.

The software packages are highlighted.

9 Tab to the OK button, then press Ctrl_A (or Keypad 0).

The Installation Setup dialog closes. An entry is created in the Installations to
be Performed list in the main window.

10 In the main window, tab to the Install button, then press Ctrl_A (or Keypad 0).

The status of all installations in the list changes to “Requested”. Packages are
installed one by one in the order that they appear in the list.

As each installation is installed, its status changes from “Requested” to “In
Progress” and finally “End”. If the installation fails, the Status column shows
“Error”.

—continued—

If Then go to

the installation fails and displays the word “Error” in
the Status column

step 11

you want to cancel the installation in progress step 12

all installations are completed and display the word
“End” or “Cancel” in the Status column

step 15
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Procedure 3-1 (continued)
Installing OPC software on a remote OPC

Step Action

11 Determine why the installation failed by checking the error messages in the
Status Messages field or see Procedure 3-5 on page 3-13.

12 To cancel the installation operation:

a. Tab to the Installations to be Performed list.

b. Move to the installation you want to cancel, then press Ctrl_A (or Keypad
0).

c. Display the list item menu by pressing Ctrl_L (or Keypad Enter ).

The list item menu appears.

d. Select the Cancel command by pressing Ctrl_A (or Keypad 0).

A confirmation dialog appears, prompting you to confirm your request to
cancel.

e. Tab to the Yes button, then press Ctrl_A (or Keypad 0).

The confirmation dialog closes. The installation is canceled and its status
changes to “Cancel”.

To continue with the next available installation in the list, go to step 14.
Otherwise, go to step 15.

Note: You must resolve any errors that caused the installation to initially fail.
Otherwise, the installation will fail again when you do step 12.

13 To retry the installation operation:

a. Tab to the Installations to be Performed list.

b. Move to the installation you want to retry, then press Ctrl_A (or Keypad
0). (The installation cannot be in the “Cancel” state.)

c. Display the list item menu by pressing Ctrl_L (or Keypad Enter ).

The list item menu appears.
—continued—

If you want to Then go to

cancel the installation. Canceling an installation in
the “Error” state may leave the backup OPC
inoperable.

step 12

retry the failed installation step 13

continue with the next available installation in the list step 14
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Procedure 3-1 (continued)
Installing OPC software on a remote OPC

Step Action

d. Move to the Retry command, then press Ctrl_A (or Keypad 0).

The installation restarts at the point in the process where it initially failed.

14 To continue with the next available installation in the Installations to be
Performed list:

a. Display the list item menu by pressing Ctrl_L (or Keypad Enter ).

The list item menu appears.

b. Move to the Continue command, then press Ctrl_A (or Keypad 0).

The next installation in the “Requested” state begins and its status
changes to “In Progress”.

15 To close the tool:

a. Display the window menu by pressing Ctrl_L W (or Keypad 6).

The window menu appears.

b. Select the Exit command by pressing Space (or Keypad 0).

The tool closes.
—end—

If Then go to

all installations are completed and display the word “End”
or “Cancel” in the Status column

step 15

the installation fails and displays the word “Error” in the
Status column

step 11

you want to cancel the installation in progress step 12

If Then go to

all installations are completed and display the word “End”
or “Cancel” in the Status column

step 15

the installation fails and displays the word “Error” in the
Status column

step 11

you want to cancel the installation in progress step 12
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Procedure 3-2
Canceling an installation

Use this procedure to cancel a software installation operation that is currently
in process.

Also, for an installation that is not taking place but is listed in the main
window, you can use this procedure to change installation status from
“Requested” or “Error” to “Cancel.”

After canceling an installation, you cannot select the Retry command in the list
item menu to reinstall the installation. Instead, you must select the Install
button in the main window.

Note: Canceling an installation in the “Error” state may leave the backup
OPC inoperable.

Requirements
To perform this procedure, you must:

• have initiated an installation operation (see Procedure 3-1 on page 3-3)

• have a userID and password that allow you access to the Remote OPC
Software Installation tool

• read the command conventions for the interface type you are using (CMT
or graphical) inOPC User Interface Description, 323-3001-301, in
Operations, Administration, and Provisioning, Volume 4A

Action

Step Action

1 Log in to the OPC and open the Remote OPC Software Installation tool.

Messages appear, indicating that the software loads will be extracted from the
tape in the tape drive.

2 When prompted to continue with the installation, enter Y, then press Return .

The main window of the Remote OPC Software Installation tool appears.

3 In the main window, tab to the Installations to be Performed list.

4 Move to the installation you want to cancel, then press Ctrl_A
(or Keypad 0).

The installation is highlighted.

—continued—
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Procedure 3-2 (continued)
Canceling an installation

Step Action

5 Display the list item menu by pressing Ctrl_L (or Keypad Enter ).

The list item menu appears.

6 Select the Cancel command by pressing Ctrl_A (or Keypad 0).

A confirmation dialog appears, prompting you to confirm your request to
cancel.

7 Tab to the Yes button, then press Ctrl_A (or Keypad 0).

The installation is terminated and its status changes to “Cancel”.

8 To close the tool:

a. Display the window menu by pressing Ctrl_L W (or Keypad 6).

The window menu appears.

b. Select the Exit command by pressing Space (or Keypad 0).

The tool closes.
—end—
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Procedure 3-3
Identifying the software release on a remote OPC

Use this procedure to display information about the operations controller
(OPC) software release currently installed on a remote OPC.

Requirements
To perform this procedure, you must:

• have a userID and password that allow you access to the Remote OPC
Software Installation tool

• read the command conventions for the interface type you are using (CMT
or graphical) inOPC User Interface Description, 323-3001-301, in
Operations, Administration, and Provisioning, Volume 4A

Action

Step Action

1 Log in to the OPC and open the Remote OPC Software Installation tool.

Messages appear, indicating that the software loads will be extracted from the
tape in the tape drive.

2 When prompted to continue with the installation, enter Y, then press Return .

The main window of the Remote OPC Software Installation tool appears.

3 Display the Utilities menu by pressing Ctrl_L T (or Keypad ,).

The Utilities menu appears.

4 Select the Query Remote Release command by pressing Space
(or Keypad 0).

The Query Remote Release dialog appears.

5 In the Destination OPCs list, move to the OPC you want to query, then press
Ctrl_A (or Keypad 0).

6 Tab to the Query Release button, then press Ctrl_A (or Keypad 0).

A dialog appears, indicating that the query is in progress. If you do not cancel
the query, the name of the release, as well as its associated packages, are
displayed in the Query Remote Release dialog.

To cancel the query, go to step 7. Otherwise, go to step 8.

7 To cancel the query:

a. Select the Stop Query button by pressing Ctrl_A (or Keypad 0).

A confirmation dialog appears, prompting you to confirm your request.

—continued—
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Procedure 3-3 (continued)
Identifying the software release on a remote OPC

Step Action

b. Tab to the Yes button, then press Ctrl_A (or Keypad 0).

The query is canceled. The confirmation dialog and the Stop Query
dialog disappear.

8 To remove the Query Remote Release dialog, tab to the Done button, then
press Ctrl_A (or Keypad 0).

The Query Remote Release dialog closes.

9 To close the tool:

a. Display the window menu by pressing Ctrl_L W (or Keypad 6).

The window menu appears.

b. Select the Exit command by pressing Space (or Keypad 0).

The tool closes.
—end—
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Procedure 3-4
Identifying the software release on the local OPC tape

Use this procedure to determine what operations controller (OPC) software
release is currently stored on the local OPC tape drive. This procedure displays
the name of the release as well as its software packages.

Requirements
To perform this procedure, you must:

• insert the appropriate tape in the local OPC tape drive

• have a userID and password that allow you access to the Remote OPC
Software Installation tool

• read the command conventions for the interface type you are using (CMT
or graphical) inOPC User Interface Description, 323-3001-301, in
Operations, Administration, and Provisioning, Volume 4A

Action

Step Action

1 Log in to the OPC and open the Remote OPC Software Installation tool.

Messages appear, indicating that the software loads will be extracted from the
tape in the tape drive.

2 When you are prompted to continue with the installation, enter Y, then press
Return .

The main window of the Remote OPC Software Installation tool appears.

3 Select the Setup button by pressing Ctrl_A (or Keypad 0).

The Installation Setup dialog appears.

4 Tab to the Query Tape button, and then press Ctrl_A (or
Keypad 0).

The name of the release and its associated packages appear in the
Installation Setup dialog.

—continued—

CAUTION
Electrostatic sensitive devices
Electrostatic sensitive devices can be damaged by
electrostatic discharge. Always ground yourself before
handling the tape.
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Procedure 3-4 (continued)
Identifying the software release on the local OPC tape

Step Action

5 To remove the Installation Setup dialog, tab to the Cancel button, then press
Ctrl_A (or Keypad 0).

The Installation Setup dialog closes.

6 To close the tool:

a. Display the window menu by pressing Ctrl_L W (or Keypad 6).

The window menu appears.

b. Select the Exit command by pressing Space (or Keypad 0).

The tool closes.
—end—
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Procedure 3-5
Viewing the Installation History dialog

Use this procedure to display status and error messages for each software
installation initiated from the local operations controller (OPC). This
information is cleared daily.

Requirements
To perform this procedure, you must:

• have a userID and password that allow you access to the Remote OPC
Software Installation tool

• read the command conventions for the interface type you are using (CMT
or graphical) inOPC User Interface Description, 323-3001-301, in
Operations, Administration, and Provisioning, Volume 4A

Action

Step Action

1 Log in to the OPC and open the Remote OPC Software Installation tool.

Messages appear, indicating that the software loads will be extracted from the
tape in the tape drive.

2 When prompted to continue with the installation, enter Y, then press Return .

The main window of the Remote OPC Software Installation tool appears.

3 Display the Utilities menu by pressing Ctrl_L T (or Keypad ,).

The Utilities menu appears.

4 Move to the View History command, then press Space (or Keypad 0).

The Installation History dialog appears, showing status and error messages
for previous installations.

5 To remove the dialog, select the Done button by pressing Ctrl_A
(or Keypad 0).

The Installation History dialog closes.

6 To close the tool:

a. Display the window menu by pressing Ctrl_L W (or Keypad 6).

The window menu appears.

b. Select the Exit command by pressing Space (or Keypad 0).

The tool closes.
—end—
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4-1

Optional commissioning procedures 4-
This chapter describes the optional commissioning tasks that you can preform
after you set up the system using one of the four following guides:

Chapter topics
The table below shows the information contained in this chapter for entering
commissioning data.

Configuration Configuration Description

• VTBM ring system
323-3001-230

This is a fiber-fed system consisting of up to sixteen
network elements connected in a bidirectional
line-switched ring (BLSR), in an AccessNode OPC span
of control.

• Point-to-point system
323-3001-240

This is a fiber-fed system consisting of a fiber central
office terminal (FCOT) and a remote fiber terminal (RFT),
in an AccessNode OPC span of control.

• Single-ended system
323-3001-245

This is a fiber-fed system consisting of one RFT,
connected to a local digital switch using a SONET
transport network (such as an OC-12 TransportNode
ring), in an AccessNode OPC span of control.

• DS1-fed (DFA) system
323-3001-235

This is a copper-fed system consisting of one RFT,
connected to a local digital switch using DS1 facilities, in
an AccessNode OPC span of control.

Topic See

Verifying the firmware load of an OC-12 VTBM circuit pack page 4-3

Transferring data from the portable to the primary OPC page 4-5

Selecting the Hong Kong PSTN software load page 4-7

Transferring data from the primary to the portable or spare OPC page 4-10

—continued—
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If you cannot successfully complete any of these procedures, contact your next
level of support.

Commissioning remote OPCs page 4-13

Clearing commissioning data from the primary or backup OPC page 4-16

De-commissioning a network element page 4-19

—end—
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Procedure 4-1
Verifying the firmware load of an OC-12 VTBM circuit
pack

Use this procedure at a VTBM ring node to verify that the latest firmware load
is present on the OC-12 VTBM (NT7E05) circuit packs and to download the
correct firmware load, if necessary. This procedure is performed using the
TCSFWDL command interface (CI) tool at the network element user interface
(NEUI).

Note: This procedure is not applicable when commissioning a shelf
without an OC-12 VTBM circuit pack. For example, an OPC shelf.

Requirements
Before starting this procedure, you must:

• be familiar with the command conventions for the interface you are using,
and procedures for connecting to a network element and for logging into
the NEUI. Refer toNetwork Element User Interface Description,
323-3001-300, inOperations, Administration, and Provisioning,
Volume 4A

• have a userID and password that allow you access to the NEUI at the admin
security level

Action

Step Action

1 Log in to the NEUI.

If you do not know how to do this, refer to the Network Element User Interface
Description, 323-3001-300, in Operations, Administration, and Provisioning,
Volume 4A.

2 Verify the firmware on the G1 and G2 VTBM circuit packs by entering:

mapci ↵
fwpui ↵
tcsfwdl ↵
query oc12vtm both  ↵
The system returns the current load name for the firmware. The format of the
load name is VTLLllnnvv.

—continued—
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Procedure 4-1 (continued)
Verifying the firmware load of an OC-12 VTBM circuit pack

Step Action

3 Verify that the load name displayed corresponds to the one printed on the
cardboard inside the software tape casing.

4 Proper firmware must be downloaded to the OC-12 VTBM circuit packs.
Transfer the firmware load from the operations controller (OPC) to the OC-12
VTBM circuit packs by entering:

download oc12vtm both ↵
5 Verify the firmware on the G1 and G2 OC-12 VTBM circuit packs by entering:

fwp ↵
query oc12vtm both ↵

6 Log out of the NEUI by entering:

logout ↵
—end—

where

VT the first two letters are always VT

LL the next two letters are one of the following:

BM for the customer loads
0D for the 0D1 loads
WN for the 1W3 loads
PR for the productions loads

ll the next two letters are either:

BL for boot load
AL for application load

nn These two numbers represent the vintage (01 for Phase 0,
02 for Phase 1, and so forth)

vv The next two to four letters represent the version

If the numbers are Then go to

consistent step 6

not consistent step 4
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Procedure 4-2
Transferring data from the portable to the primary
OPC

Use this procedure to transfer commissioning data for a span of control from
the portable operations controller (OPC) to the primary OPC, after all the
network elements (NEs) in the span are commissioned. Data transfer is faster
when the portable OPC is attached to the NE with the primary OPC. You can
also transfer data from any commissioned NE.

When you use this procedure to transfer data to the primary OPC, all previous
data on the primary OPC is destroyed. Also, the primary OPC goes out of
service during the transfer. Therefore, you must complete all commissioning
procedures that define system or NE data, before executing this procedure. The
prerequisite procedures are defined in the chapter task list in Chapter 1.

Requirements
Before starting this procedure, you must

• make sure the system is not in service

• complete the commissioning of all NEs

• connect a terminal to the OPC and the OPC to the NE at any NE with
Synchronous Optical Network (SONET) continuity to the primary OPC.
This is specified inOPC User Interface Description, 323-3001-301, in
Operations, Administration, and Provisioning,Volume 4A.

• make sure the primary OPC is installed in its slot and initialized

• have a userID and password that permit access to the OPC and use of the
Commissioning Manager and Shutdown tools

• be familiar with the command conventions for the interface you are using
(CMT or graphical) as described inOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning,
Volume 4A

—continued—
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Procedure 4-2 (continued)
Transferring data from the portable to the primary OPC

Action

Step Action

1 Log in to the portable OPC and open the Commissioning Manager tool.

For information on the OPC, refer to OPC User Interface Description,
323-3001-301, and Data Administration Procedures, 323-3001-304, in
Operations, Administration, and Provisioning, Volume 4A.

The Commissioning Manager main window is displayed.

2 Tab to the Transfer Data to Primary OPC button and select it by pressing
Ctrl_4 .

A confirmation dialog is displayed.

3 Tab to the OK button and select it by pressing Ctrl_A (or Keypad 0).

The commissioning data is copied from the portable OPC to the primary
OPC. This can take several minutes. When the process is complete, a
notification dialog is displayed.

Note: If anything goes wrong with the transfer, use the Event Browser to
check for logs describing the problem, as described in Network Surveillance
Procedures, 323-3001-510, in Maintenance, Volume 5C.

4 Select the Done button by pressing Ctrl_A (or Keypad 0).

5 Close the Commissioning Manager tool:

a. Display the Window menu by pressing Ctrl_L W (or Keypad 6).

The Window menu is displayed.

b. Select Exit to return to the User Session Manager screen.

6 Open the OPC Shutdown tool.

For information on this, refer to Data Administration Procedures,
323-3001-304, in Operations, Administration, and Provisioning, Volume 4A.

The OPC Shutdown main window is displayed.

7 Shut down the portable OPC. For additional information, refer to Data
Administration Procedures, 323-3001-304, in Operations, Administration,
and Provisioning, Volume 4A.

—end—
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Procedure 4-3
Selecting the Hong Kong PSTN software load

Use this procedure to load the Public Switching Telecommunications Network
(PSTN) software load for Hong Kong. Do not perform this procedure unless
you are installing a network element (NE) in Hong Kong. The default PSTN
software load is for North American.

Requirements
Before starting this procedure, you must:

• make sure the system is not in service

• commission the NE that you want to convert to the Hong Kong PSTN
software load

• be familiar with the command conventions for the interface you are using
(CMT or graphical) as described inNetwork Element User Interface
Description, 323-3001-300, andOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning,
Volume 4A

Action

Step Action

1 Log in to the operations controller (OPC).

For information on the OPC, refer to OPC User Interface Description,
323-3001-301, and Data Administration Procedures, 323-3001-304, in
Operations, Administration, and Provisioning, Volume 4A.

2 Open the NE Login Manager tool.

3 Select Auto Login to log in to the NE that you want to convert from the default
North American PSTN software load to the Hong Kong PSTN software load.

The Network Element User Interface (NEUI) screen is displayed.

—continued—

CAUTION
Affects service
Changing PSTN compliancy drops all active calls
and cancels all active line testing.
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Procedure 4-3 (continued)
Selecting the Hong Kong PSTN software load

Step Action

4 At the prompt enter:

quit all ↵
The command interface (CI) prompt appears.

5 Open the PSTN CI tool by entering:

pstnci ↵
The PSTN CI tool loads.

6 Display the command list for the PSTN CI tool by entering:

help ↵
The PSTN help screen appears.

7 Query the status of the PSTN software load by entering:

qpstn ↵
The PSTN tool displays the present status of the system.

This system is currently configured for North America
PSTN.

8 If the NE is in Hong Kong, change the PSTN software load from the default
North American software load to the Hong Kong PSTN software load by
entering:

selhk ↵
The PSTN CI displays a warning and asks you to confirm the change.

******************** WARNING *************************
Changing PSTN compliancy drops active calls providing
LSR services and aborts all active line testing.

******************************************************

Please confirm (“Yes” or “No”)

—continued—

If you want to Then enter

confirm the
change

yes ↵
The PSTN tool displays the message:

System now compliant to Hong Kong PSTN.
Affected line cards are being downloaded.

cancel the
change

no ↵
The PSTN tool cancels the action.
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Procedure 4-3 (continued)
Selecting the Hong Kong PSTN software load

Step Action

9 Query the status of the PSTN software load by entering:

qpstn ↵
The PSTN tool displays the present status of the system.

This system is currently configured for Hong Kong PSTN.

10 Close the PSTN CI tool by entering:

quit ↵
The PSTN CI tool closes and the CI prompt is displayed.

11 Log out of the NE by entering:

logout ↵
The tool closes and returns you to the NE Login Manager screen.

12 Close the NE Login Manager tool:

a. Display the Window menu by pressing Ctrl_L W (or Keypad 6).

The Window menu is displayed.

b. Select the Exit command by pressing the space bar (or Keypad 0).

13 Log out of the OPC.

For information on the OPC, refer to OPC User Interface Description,
323-3001-301, in Operations, Administration, and Provisioning, Volume 4A.

—end—
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Procedure 4-4
Transferring data from the primary to the portable or
spare OPC

Use this procedure to transfer commissioning data from the primary operations
controller (OPC) to the portable or spare OPC.

This procedure is required when a new network element (NE) is being added
to an existing OPC span of control. Since the primary OPC must remain in its
shelf, the portable or spare OPC is carried to the site of the new NE to
download software.

This procedure must be performed from the primary OPC.

Requirements
Before starting this procedure, make sure the system is not in service.

Before performing this procedure, you must:

• attach the portable or spare OPC to any NE in the span of control

• attach a terminal to the primary OPC as specified inOPC User Interface
Description, 323-3001-301, inOperations, Administration, and
Provisioning,
Volume 4A

• enter the commissioning data for the new NE at the primary OPC

• have a userID and password that permit access to the portable OPC and use
the Commissioning Manager tool

• have the portable or spare OPC serial number from the bar code at the back
of the unit or from the motherboard of the processor

• be familiar with the command conventions for the OPC interface you are
using (CMT or graphical) as described inOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning, Volume
4A

—continued—
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Procedure 4-4 (continued)
Transferring data from the primary to the portable or spare OPC

Action

Step Action

1 Log in to the primary OPC and open the Commissioning Manager tool.

For information on the OPC, refer to OPC User Interface Description,
323-3001-301, in Operations, Administration, and Provisioning, Volume 4A.

The Commissioning Manager main window is displayed.

2 Display the Options tool menu by pressing the Ctrl_L T (or Keypad,).

The Options tool menu is displayed.
3 Select the Transfer Data command by pressing the space bar (or Keypad 0).

The OPC Data Transfer dialog is displayed.

4 Select SLAT OPC by pressing Ctrl_A (or Keypad 0).

A diamond is displayed beside the SLAT OPC entry.

5 Tab to the OK button and select it by pressing Ctrl_A (or Keypad 0).

A confirmation dialog is displayed, with a message indicating that the
contents of the portable OPC will be overwritten if you proceed.

6 From the Confirmation Dialog, enter the serial number of the portable or
spare OPC.

OPC serial numbers have the following format:

A<n><hhhhhhh>

(Example: A1b3e01be)

Note 1: On a portable OPC, the serial number is provided as a bar code at
the rear of the OPC case. It is also printed at the bottom center of the
motherboard within the OPC, although the portable OPC case must be
removed to read it. It is also displayed in the upper right corner of the
Commissioning Manager main window, but only if you are logged into the
portable OPC.

Note 2: On the spare OPC, the serial number is printed at the bottom center
of motherboard.

Note 3: If this serial number is not accepted, call Nortel Networks for technical
assistance. For a list of the technical assistance telephone numbers, refer to
the Technical Support Reference Card located in the front pocket of your NTP.

—continued—

where

<n> is a one-digit integer between 0 and 9

<hhhhhhh> is a seven-digit hexadecimal number
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Procedure 4-4 (continued)
Transferring data from the primary to the portable or spare OPC

Step Action

7 Tab to the OK button and select it by pressing Ctrl_A (or Keypad 0).

The commissioning data is transferred from the primary OPC to the portable
OPC. This can take several minutes. When the process is complete, a
notification dialog is displayed.

8 Select the Done button by pressing Ctrl_A (or Keypad 0).

9 Close the Commissioning Manager tool:

a. Display the Window menu by pressing Ctrl_L W (or Keypad 6).

The Window menu is displayed.

b. Select Exit by pressing the space bar (or Keypad 0).

You are returned to the User Session Manager.
—end—
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Procedure 4-5
Commissioning remote OPCs

Use this procedure to commission remote operations controller (OPC)
addresses and/or the portable OPC address.

Requirements
Before starting this procedure, you must:

• make sure the system is not in service

• have the serial numbers of the OPCs to be commissioned

Note:The serial number of a modular OPC is located at the bottom center
of the motherboard, on the right side (when looking at the faceplate). The
serial number of a portable OPC is on a bar code label at the rear of the
portable OPC case. It is also printed at the bottom center of the
motherboard within the OPC, although the portable OPC case must be
removed to read it.

• have a userID and password that permit access to the OPC and use the
Commissioning Manager

• be familiar with the command conventions for the OPC interface you are
using (CMT or graphical) as described inOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning, Volume
4A.

• have a copy or copies of your mapper planning worksheets from
“Appendix A: Worksheets” in theMapper Layouts Planning Guide,
323-3001-154, inEngineering, Configuration, and Ordering Guide,
Volume 1

—continued—
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Procedure 4-5 (continued)
Commissioning remote OPCs

Action

Step Action

1 Log in to the primary OPC and open the Commissioning Manager tool.

For information on the OPC, refer to OPC User Interface Description,
323-3001-301, in Operations, Administration, and Provisioning, Volume 4A.

The Commissioning Manager main window is displayed.

2 Display the Options tool menu by pressing Ctrl_L T (or Keypad,).

The Options tool menu is displayed.

3 Move the cursor to the Remote OPC List command and select it by pressing
the space bar (or Keypad 0).

The Remote OPC Commissioning Data dialog is displayed. This dialog lists
all the remote or portable OPCs that the controlling OPC can communicate
with in the current span of control.

4 To commission a new remote OPC, select the Add Remote OPC button by
pressing Ctrl_A (or Keypad 0).

The OPC Commissioning Data dialog is displayed.

5 Your cursor should be at the OPC name field. At this field, if the OPC name
does not appear, enter a node name for this remote OPC. OPC node names
must be unique within the network and have the following format:

OPC <xxxx> (for example: OPC27JF)

6 Tab to the Primary OPC serial number field and enter the serial number of the
remote primary OPC.

OPC serial numbers have the following format:

A<n><hhhhhhh>

(Example: A1b3e01be)

Note: If this serial number is not accepted call Nortel Networks for technical
assistance. For a list of the technical assistance telephone numbers, refer to
the Technical Support Reference Card located in the front pocket of your NTP.

—continued—

where

<x> is any integer from 0 to 9 or any letter from A to Z

where

<n> is a one-digit integer between 0 and 9

<hhhhhhh> is a seven-digit hexadecimal number
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Procedure 4-5 (continued)
Commissioning remote OPCs

Step Action

7 To specify an alias for the remote primary OPC, tab to the Primary OPC alias
field and enter it there. The name can consist of up to 8 alphanumeric
characters; for example, primary1, northp1, or chicago2.

8 If there is a remote backup OPC, fill in the Backup OPC serial number and
Backup OPC alias fields in the same way as described in steps 6 and 7.

9 Record this data on the Commissioning Data Record Form.

10 To complete the entry of OPC commissioning data, tab to the OK button and
select it by pressing Ctrl_A (or Keypad 0).

An entry for this OPC is added to the Remote OPCs list on the Remote OPC
Commissioning Data dialog.

11 Tab to the Done button and select it by pressing Ctrl_A (or Keypad 0).

12 To close the tool:

a. Display the Window menu by pressing Ctrl_L W (or Keypad 6).

The Window menu is displayed.

b. Select the Exit command by pressing the space bar (or Keypad 0).

You are returned to the User Session Manager.
—end—
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Procedure 4-6
Clearing commissioning data from the primary or
backup OPC

Use this procedure to clear OPC commissioning data from the primary or
backup operations controller (OPC) in a span of control that is commissioned.
This procedure can be used on modular or portable OPCs.

This procedure consists of two subsections as follows:

• Clearing OPC commissioning data

• Clearing NE commissioning data

Before proceeding, make sure you are working in the UNIX environment.

Requirements
Before starting this procedure, you must:

• make sure the system is not in service

• have the root user ID and password

• be familiar with the command conventions for the OPC interface you are
using (CMT or graphical) as described inOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning, Volume
4A

Note: If you are clearing commissioning data from a backup OPC, the
backup OPC must be in-service active in order to open the Commissioning
Manager tool later in this procedure.

—continued—
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Procedure 4-6 (continued)
Clearing commissioning data from the primary or backup OPC

Action

Step Action

Clearing OPC commissioning data

1 Log in to the primary or backup OPC as the root user.

If you do not know how to do this, refer to OPC User Interface Description,
323-3001-301, in Operations, Administration, and Provisioning, Volume 4A.

The opc> prompt is displayed.

2 At the opc> prompt, type opcui. This displays the User Session Manager
window.

3 Under the Restricted Tools section, select the Enable Clear Com’g option by
pressing Ctrl_A (or Keypad 0).

This displays the following command menu:

1. Display commissioning data
2. Delete primary OPC
3. Delete backup OPC
4. Enable clear commissioning data
5. Quit

Enter the number for your selection:

4 Choose an option as follows:

• Select option 1 to display the OPC commissioning data.

• Select option 2 to clear only the primary OPC commissioning data.

• Select option 3 to clear only the backup OPC commissioning data.

• Select option 4 to clear commissioning data for both the primary and
backup OPCs. When you choose this option, it also activates the Clear
Commissioning data button in the Commissioning Manager window.
Once this button is activated, you can use it to clear the NE
commissioning data. For more information, proceed to the next section.

Clearing NE commissioning Data

5 To clear NE commissioning data, select the Enable Clear Commissioning
Data option by entering the following:

4↵
This displays the following message:

“This command will alter the OPC’s commissioning data. Are
you sure? (Yes/No)

—continued—
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Procedure 4-6 (continued)
Clearing commissioning data from the primary or backup OPC

Step Action

6 Select Yes.

This clears the commissioning data for the primary and backup OPCs and
enables the Clear Com’g data button in the Commissioning Manager window.
This is indicated when the word “Done” appears.

7 To quit, enter the following:

5↵
This returns you to the User Session Manager menu.

8 To clear all NE commissioning data, go to the SLAT section of the User
Session Manager menu. Under SLAT, go to the Commissioning Mgr option
and select it by pressing Ctrl_A (or Keypad 0).

This displays the Commissioning Manager main window.

9 Tab to the Clear Com’g Data button and select it by pressing Ctrl_A (or
Keypad 0).

This displays the following confirmation dialog:

“This operation will remove any existing commissioning
data on this OPC. Do you wish to continue?” (Yes/No)

10 Tab to the Yes button and select it by pressing Ctrl_A (or Keypad 0).

This displays the following dialog stating that the OPC is out of service.

“This OPC is out of service. Some tools may need to be
closed as a result and have entered the ERROR state.
Please close all tools that have an error
message.(Done/Return)”

11 Tab to the Done button and select it by pressing Ctrl_A (or Keypad 0).

A dialog box appears stating the following:

“Commissioning has been successfully cleared.
(OK/Return)”

12 Tab to the OK button and select it by pressing Ctrl_A (or Keypad 0).

A dialog box appears stating the following:

“This OPC has just entered the active state. Normal
operations will resume.(Done/Return)”

13 Tab to the Done button and select it by pressing Ctrl_A (or Keypad 0).

14 Close the Commissioning Manager tool as follows:

a. Display the Window menu by pressing Ctrl_L W (or Keypad 6).

This displays the Window menu.

b. Select the Exit command.

This returns you to the User Session Manager.
—end—
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Procedure 4-7
De-commissioning a network element

Use this procedure to deconfigure a point-to-point system and to
de-commission a network element from an operations controller (OPC) span
of control.

Requirements
Before starting this procedure, make sure the system is not in service.

To perform this procedure, you must.

• have a userID and password that permit access to the OPC and use the
Configuration Manager, Provisioning Manager, Facility Assignment
Manager, and Connections Manager tools

• have a copy or copies of your mapper planning worksheets from
“Appendix A: Worksheets” in theMapper Layouts Planning Guide,
323-3001-154, inEngineering, Configuration, and Ordering Guide,
Volume 1

• be familiar with the command conventions for the OPC interface you are
using (CMT or graphical) as described inOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning, Volume
4A

Note: Before de-commissioning an NE you must first delete the digital
multiplex switch (GR-303 DMS/MVI), universal digital loop carrier
(UDLC), and DS1-tandem services and connections associated with the
NE.

Action

Step Action

1 Log into the active OPC.

For information on the OPC refer to OPC User Interface Description,
323-3001-301, in Operations, Administration, and Provisioning, Volume 4A.

2 Open the PGTC/MTA Provisioning Manager tool under the SLAT toolset and
delete any UDLC and/or DS1 Tandem services associated with the NE.

For information on the PGTC/MTA Provisioning Manager, see the procedure
for deleting a circuit in Line Card Provisioning Procedures, 323-3001-315, in
Operations, Administration, and Provisioning, Volume 4B.

—continued—
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Procedure 4-7 (continued)
De-commissioning a network element

Step Action

3 Close the PGTC/MTA Provisioning Manager.

4 At the SMA, delete all GR-303 DMS/MVI services associated to this NE.
Refer to SMA documentation for the proper procedures.

Note: The Commissioning Manager allows the user to de-commission an NE
even if there are still GR-303 DMS/MVI services provisioned. However, if the
NE is de-commissioned without deleting the GR-303 DMS/MVI services, it
will become very difficult to delete those lines from the SMA afterwards.

5 Open the Configuration Manager tool under the SLAT toolset.

The Configuration Manager main window is displayed.

6 In the configuration list, move to the configuration that is associated with the
NE that you wish to decommission and display the List item menu by pressing
the Ctrl_L (or Keypad Enter ).

The List item menu is displayed.

7 Select the Edit/Delete Configuration command by pressing Space
(or Keypad 0).

The Configuration Manager: Point-to-Point window is displayed in the Edit
mode.

8 Display the Options menu by pressing Ctrl_L T (or Keypad ,).

The Options menu is displayed.

9 Select the Delete configuration command.

A confirmation dialog is displayed.

10 Tab to the Yes button and select it by pressing Ctrl_A (or Keypad 0).

Data for the configuration is cleared from all fields in the window and the
deletion is saved to the primary OPC. The Configuration Manager:
Point-to-Point window is displayed in the Add mode.

11 Display the Window menu by pressing Ctrl_L W (or Keypad 6).

The Window menu is displayed.

12 Select the Exit command by pressing Space (or Keypad 0).

If a backup OPC exists, the following dialog is displayed. If no backup OPC
exists, skip to step 15.

—continued—
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Procedure 4-7 (continued)
De-commissioning a network element

Step Action

13 To transfer the new configuration data to the backup OPC, tab to the
Yes button and select it by pressing Ctrl_A (or Keypad 0).

A confirmation dialog is displayed.

14 Tab to the Yes button and select it by pressing Ctrl_A (or Keypad 0).

The Configuration Manager main window appears.

Note: You can receive a warning dialog informing you that the backup OPC
is unavailable and to try again later. The new configuration is still saved to the
primary OPC and is listed in the configuration list.

15 Close the Configuration Manager tool:

a. Display the Window menu by pressing Ctrl_L W (or Keypad 6).

The Window menu is displayed.

b. Select the Exit command by pressing the space bar (or Keypad 0).

You are returned to the User Session Manager.

16 Open the Commissioning Manager tool.

The Commissioning Manager main window is displayed.

17 Tab to the Commissioned network elements list, move the cursor to the NE
you plan to de-commission and select it.

The selected network element is highlighted.

18 Display the List item menu by pressing Ctrl_L (or Keypad Enter ).

The List item menu is displayed.

19 Move the cursor to the Delete command and select it.

A delete network element confirmation dialog is displayed.

Note: Depending on your system, additional information can be displayed in
this dialog.

20 Tab to the Yes button, and select it by pressing Ctrl_A (or Keypad 0).

The confirmation dialog is removed. The NE is de-commissioned and
removed from the list in the main window.

—continued—

If Then

you do not want to transfer the
data to the backup OPC

• select the No button
The Configuration Manager main window is
displayed.

• go to step 15

you want to transfer the data
to the backup OPC

go to step 14



4-22 Optional commissioning procedures

AccessNode Vol 3B 323-3001-220 Issue 2.0

Procedure 4-7 (continued)
De-commissioning a network element

Step Action

21 Close the Commissioning Manager tool:

a. Display the Window menu by pressing Ctrl_L W (or Keypad 6).

The Window menu is displayed.

b. Select the Exit command by pressing the space bar (or Keypad 0).

The User Session Manager returns.

22 To make the changes fully effective, reboot the OPC. To reboot the OPC, use
the OPC Shutdown tool with the restart option. For steps on how to use this
tool, refer to the procedure for shutting down an OPC in Data Administration
Procedures, 323-3001-304, in Operations, Administration, and Provisioning,
Volume 4A.

—end—
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5-1

OPC Ethernet port configuration and
connections 5-

The following topics are covered in this chapter:

• establishing communications for the operations controller (OPC) and an X
terminal, an Ethernet local area network (LAN), or the Network Manager

• specifying hardware and software setup requirements for
X terminals supported by the OPC

• connecting X terminals to the OPC and configuring the OPC for
X terminal communications

Note:For information on the OPC graphical user interface for X terminals,
and the OPC tools available through this interface, seeOPC User Interface
Description, 323-3001-301, inOperations, Administration, and
Provisioning,Volume 4A.

X terminals are graphic terminals that have local memory, a processor, and
software to support the X Window System. X terminals handle the graphic
display functions locally for applications running within the OPC. The OPC
also has X Window software that allows the OPC to control X terminal
displays and run X clients.

The X Display Manager (XDM) on the OPC generates a log in banner that is
displayed on the X terminal displays. The user provides log in information
through this log in banner and the XDM starts the session if the log in
information is correct. The XDM also handles session termination.
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Chapter topics
The following table lists the topics in this chapter. These topics are procedures
that you follow to help you set up OPC Ethernet port configurations and
connections.

If you cannot successfully complete these procedures, contact your next level
of support.

X terminal support
The X terminals supported by the OPC include the following:

• models NCD19 (the NCD19 is recommended) and NCD19R,
manufactured by Network Computing Devices of Mountain View,
California. In this document, the term NCD19 is used for both the NCD19
and the NCD19R

• model 700/RX, manufactured by Hewlett-Packard
• model XP18, manufactured by Tektronix

The OPC automatically provides the OPC font path to supported X terminals
as well as keyboard mapping. Keyboard mapping for unsupported terminals is
not guaranteed.

X terminal models other than those listed above may connect to the OPC. If
the OPC log in banner displays after a reboot of an X terminal connected to the
appropriate OPC port, then the OPC automatically provides the OPC font path
to the X terminal. For this to happen, the X terminal must be able to have its
font path changed remotely from a host.

Procedure Task See

5-1 Initializing the OPC Ethernet port page 5-15

5-2 Controlling the OPC Ethernet port page 5-20

5-3 Connecting the OPC to network equipment page 5-23

5-4 Establishing a Telnet session between an X terminal and
the OPC

page 5-25

5-5 Adding, changing, or deleting an NCD19 configuration file page 5-26

5-6 Loading the NCD19 configuration data from the OPC to an
NCD19 X terminal running NCDware v.2

page 5-30

5-7 Loading the NCD19 configuration data from the OPC to an
NCD19 X terminal running NCDware v.3

page 5-32

5-8 Reconfiguring X terminals following an OPC upgrade page 5-33
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Note:When using X terminals to access an OPC, you must make sure that the
trivial file transfer protocol (TFTP) entry exists in the /etc/inetd.conf file of the
OPC. By default, the following TFTP entry should exist in the /etc/inetd.conf
file.

# entry for trivial file transfer protocol (TFTP)
tftp dgram udp wait root /etc/tftpd tftpd -s /iws/X11/font

Do not remove the above entry from the inetd.conf file of the OPC. Without
this entry an X terminal can have unexpected problems, such as font problems,
login banner not appearing, and so forth.
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X terminal equipment recommendations
The following general recommendations apply to all X terminals with specific
recommendations for each X terminal model.

General recommendations
The following recommendations apply to all X terminals.

• in order to communicate with the OPC, the X Server software must run
with version X 11, Release 4 (X11 R4)

• X terminals connected to the OPC, either directly or through a hub on a
LAN, should be configured with a twisted-pair communication port (the
IEEE 802.3 10BaseT interface). The physical port is an RJ45 connector

• X terminals must be equipped with local X server communications
software as the OPC does not support downloading of X server
communications software

Communications software is available from the vendor in the form of
an X server programmable read only memory (PROM) or an X server
flash ROM. If local communications software is not provided, there
must be a network server available to the X terminal(s) that can provide
it. When setting up the X terminal, it is necessary to identify the server.

Note: The equipment lists that follow are subject to vendor-initiated
changes that are beyond the control of Nortel Networks. Therefore, if the
specified equipment is not available, use the lists to duplicate
recommended configuration.

NCD equipment
The NCD19 model should be ordered as follows:

• NCD19 X terminal model

• 19-inch monochrome (19RP15TWKP) or color (19CP17TWKP) monitor

• X server PROM

• 8 megabytes of random access memory (RAM)

• N-101 keyboard

Hewlett-Packard equipment
The 700/RX model should be ordered as follows:

• 700/RX X terminal model

• 19-inch monochrome monitor

• 8 megabytes of RAM (in addition to the 2 megabytes of basic RAM)

• X server and fonts on ROM card

• North American HIL keyboard
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Tektronix equipment
The XP18 model should be ordered as follows:

• XP18 X terminal model

• 17-inch color monitor

• 8 megabytes of RAM

• 2 megabytes of flash ROM

• boot ROM and fonts

• PC keyboard

X terminal setup requirements
This section specifies the following parameter values that must be set on X
terminals in order for them to operate with the OPC:
• IP addresses and node names

• General setup requirements

• NCD-specific requirements

• 700/RX-specific requirements

• XP18-specific requirements

The parameters listed here represent only those required for connection to the
OPC.

Other operating environment characteristics, such as router types and LAN
configurations, must be considered because the setting of other parameters to
specific values are often required. Contact the terminal vendor to identify the
appropriate value based on the type of router or the LAN configuration you are
using.

IP addresses and node names
Both the Internet Protocol (IP) address and the node name can be assigned
according to your network requirements. However, note the following
restrictions:

• all addresses and names must be unique within the network

• if the local network is to be connected to an external network, the IP
address must conform to DARPA allocation standards to make sure the IP
addresses are unique

Get the IP addresses and node names from the communications planning
department in your organization. However, if the IP addresses are not
available, then get the IP addresses directly from DARPA.
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General setup requirements
For operation with the OPC, the following parameters must be set up on all X
terminals:

• for an X terminal used in another application, reset the terminal to its
factory defaults before setting up the other parameters listed here

• specify the IP address of the X terminal

• set the terminal for remote configuration

• for the remote configuration host, specify the IP address of the OPC

• for the remote configuration file access, specify TFTP

Note:The term “remote configuration” is generic. Each manufacturer has
its own term. Contact the manufacturer’s representative if the X terminal
documentation does not use the remote configuration terminology.

• if your network uses node names, specify the node name (IP address alias)
for both the X terminal and the OPC

NCD-specific requirements
When an NCD19 X terminal reboots, the XDMCP enable flag and the IP
address of the OPC are lost. To compensate for this, the OPC provides an
automatic process for re-establishing these parameters on the NCD X terminal.
This automatic process requires that a configuration file be created on the OPC
for each NCD X terminal. Instructions for adding, changing, or deleting entries
in the configuration file are provided in Procedure 5-5 on page 5-26 in this
chapter.

700/RX-specific requirements
In addition to the general setup requirements, the 700/RX must have the
following parameters defined:

• enable XDMCP with Direct Access

• for the XDMCP host, specify the IP address of the OPC

XP18-specific requirements
In addition to the general setup requirements, the XP18 requires the definition
of the following Host File Access configuration parameters:

• enable XDMCP with Direct Access

• for the XDMCP host, specify the IP address of the OPC

• under Host File Access, set the Primary XP File Root to “/usr/lib/X11/XP”
(quotes not included)

The flash ROM for XP18 X terminals is not always delivered with the X server
software burned in it. In such a case, download the X server communications
software from a network server to the flash ROM. Download it only once.
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Note: The OPC does not provide X server communications software
download capability.

Instructions for X terminal setup
Refer to the X terminal documentation for specific instructions on setting up
the X terminal. Contact the X terminal representative if problems arise.

Once the parameters are defined, they must be saved to non-volatile random
access memory (NVRAM). To activate the parameters, the X terminal must be
rebooted.

Replacing or exchanging X terminals
If an X terminal is replaced, either with the same or a different vendor’s
equipment, the full setup procedure for the new terminal must be followed (as
specified in the vendor’s documentation). This is true even if the IP address is
kept the same.

LAN considerations
The following issues should be considered when the OPC is connected to a
LAN:

• When there is wide-area network (WAN) access to the LAN, the OPC does
not distinguish between X terminals on the local LAN and other X
terminals located anywhere on the WAN. This can present a security issue
that should be addressed through LAN and WAN administration.

• The OPC assumes that any user session from an OPC is started directly
from an X terminal.

Logins to the OPC through X terminal sessions running on an intermediate
host are not recommended because problems with the LAN segment
between the OPC and the host or the host and the X terminal, could affect
the OPC user session. Problems with this type of setup are beyond the
control of the OPC.

• LAN configuration (that is, routers, hubs, connectors) and proper use of
LAN resources is the responsibility of the customer.

• Consider the impact on LAN integrity and performance that results when
X terminals are connected to an OPC over the LAN.

Analysis of the particular LAN is recommended since LAN configurations
vary widely, making general guidelines inappropriate. LAN engineers
using a protocol analyzer can perform the required analysis.

Note: X clients running from an OPC are the same as X clients running
from a UNIX workstation.

• Modem connections with X terminals over serial lines are not supported on
the OPC (including access through the serial line protocol XRemote).

• Only one user session from one OPC is supported on an X terminal.
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Cabling options
X terminals, LANs, and Nortel Networks’ Network Manager connect to the
OPC using the Ethernet port on the faceplate of the OPC. Figure 5-1 on
page 5-9 shows the cabling options for connecting the OPC to network
equipment.
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Figure 5-1
Cabling options for connecting the OPC to the network element
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Connector pin-outs
Figure 5-2 below shows the pinouts for the Dupont and RJ45 connectors.

Figure 5-2
Connector pin-outs for the Dupont and RJ45 connectors

PC-21702

Cabling option A
Option A applies when there is a point-to-point connection between the OPC
and an X terminal that supports the recommended twisted-pair communication
port (the IEEE 802.3 10BaseT interface).

Nortel Networks’ pre-fabricated cables have a 2×  3 Dupont male connector
on one end for connection to the OPC. The other end has an RJ45 connector
for connection to the X terminal. Each cable has two shielded twisted pairs
with transmit and receive crossed over. The cables conform to FCC Class A
requirements. The available cables are as follows:

X terminal crossover cables

Length Product Engineering Code (PEC)

20 m (65 ft) NT4K86SB

40 m (130 ft) NT4K86SC

100 m (325 ft) NT4K86SD

Dupont connector

RJ45 connector

FW-21702

1 3 5

2 4 6
Dupont connector
pin assignment

RJ45 connector
pin assignment

1 8



OPC Ethernet port configuration and connections 5-11

AccessNode Optional Commissioning Procedures 323-3001-220 Issue 2.0

Pin assignments for the crossover cables are shown in the following table:

Cabling option B
Option B applies when there is a point-to-point connection between the OPC
and an X terminal and the X terminal has a 15-pin D-type connector that
conforms to the IEEE 802.3 pin configuration. Nortel Networks’ prefabricated
cables for this application have a 2×  3 Dupont male connector on one end for
connection to the OPC. The other end has an RJ45 connector for connection to
the
X terminal. For Option B, a media access unit (MAU) is required to interface
between the RJ45 IEEE 802.3 connector of the straight through cable and the
15-pin D-type IEEE 802.3 connector on the X terminal. The MAU provides the
crossover function (and connector conversion). The Hewlett-Packard
HP28685B Ethertwist Transceiver is a suitable MAU.

Each cable has two shielded twisted pairs with transmit and receive wired
straight through. The cables conform to FCC Class A requirements. The
available cables are as follows:

Pin assignments for the straight-through cables are shown in the following
table:

Dupont connector pin number RJ45 connector pin number

1 Tx+ 3 Rx+

2 Tx- 6 Rx-

5 Rx- 2 Tx-

6 Rx+ 1 Tx+

X terminal straight-through cables

Length Product Engineering Code (PEC)

20 m (65 ft) NT4K86LA

40 m (130 ft) NT4K86LB

100 m (325 ft) NT4K86LC

Dupont connector pin number RJ45 Connector pin number

1 Tx+ 1 Tx+

2 Tx- 2 Tx-

5 Rx- 6 Rx-

6 Rx+ 3 Rx+
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Cabling option C
Option C applies when the OPC is connected to a LAN. In this case, the
straight-through cables NT4K86LA, LB, LC are used to connect the OPC to
the LAN hub.

Session-terminating conditions
The OPC sends an audit message to the X terminal every minute and
terminates an active user session if the X terminal does not respond within one
minute. Any condition that prevents the X terminal from responding to the
audit causes the session to terminate.

NCD19, pre-NCDware v.3 and HP 700/RX considerations
For NCD19 X terminals running pre-NCDware v.3 software and for HP
700/RX X terminals, the terminal does not respond to OPC audit messages
when it is in the Setup mode. To avoid a session termination when in the Setup
mode, perform configuration changes when there is no session established
between the X terminal and the OPC.

OPC window relocation considerations
When you want to relocate a window, the window is represented by a wire grid
image that moves around the screen under control of the mouse. The actual
window reappears when you select the new location. The OPC does not
respond to audit messages while the wire grid is displayed. To avoid session
termination, select the new location for the window within one minute.

Troubleshooting guidelines for X terminals
This section provides troubleshooting guidelines for the most common
problems when connecting X terminals to the OPC.

700/RX and XP18: OPC login banner does not appear
Some versions of the HP 700/RX and Tektronix XP18 X terminal software
have a factory-set time period that applies during the call setup portion of a
connection. The terminals wait for a response from the remote end for this
pre-defined period. If there is no response, the terminals stop polling the
remote end. This is a limitation of the XDMCP functionality on these X
terminal models and, generally, the time period is not configurable.

If the OPC is rebooting when one of these terminals initiates call setup, it is
possible that the time period will be exceeded before the OPC responds. In this
case, the OPC login banner never reappears. To get the OPC login banner to
reappear in such situations, reboot the X terminal after the OPC has returned
to service (allow five to ten minutes for the OPC to reboot).
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No OPC login banner after a power failure
When a power failure occurs on both the OPC and the X terminals connected
to it, the X terminals always come back up before the OPC, assuming power is
restored simultaneously on both. In this case, the OPC login banner does not
reappear on these X terminals either because:

• the X terminals give up polling the OPC after a predefined time period (as
is the case for the HP 700/RX and Tektronix XP18)

• the X terminals cannot read their remote configuration file on the OPC
while the OPC is rebooting (as is the case for the NCD19)

To get the OPC login banner to reappear in such situations, reboot the X
terminals after the OPC has returned to service (allow five to ten minutes for
the OPC to reboot).

NCD19 v.3 post-failure windows and dialog boxes
Under some failure scenarios, NCDware version v.3 for the NCD19 displays
specific windows and dialog boxes. The two most common scenarios are loss
of connection during an active OPC session and unavailability of the OPC
while the X terminal is trying to establish a connection.

Loss of connection during an active OPC session
Loss of connection during an active OPC session can occur when the OPC
experiences a power failure or when the Ethernet connection between the OPC
and the X terminal is disabled. In such a case, a dialog with the following
message is displayed on the X terminal screen:

TCP login manager on “OPC IP address” not responding. There are
X local and Y remote applications running. Shutdown windows and
logout?

Select the Yes button when it is displayed.

Unavailability of the OPC during the call setup phase
If the OPC is unavailable while the NCD19 is trying to establish a connection,
the NCD19 X terminal gives up trying to connect to the OPC after a specified
amount of time. Usually, this occurs after rebooting the OPC. A window is
then displayed with the following message:

Login host not responding; choose another or try again later?

Wait until the OPC has returned to service (allow approximately five minutes
for the OPC to reboot), then select the OK button on this window. The OPC
login banner from the OPC is displayed.
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Problems connecting over a LAN
Almost all problems associated with LANs arise because of LAN
interconnectivity issues that are independent of the OPC, and these LAN
problems often prevent communications with the OPC. Contact the LAN
vendor since most issues can be quickly resolved by them.

Engineering guidelines for OPC X terminal sessions
A maximum of four X terminals can be running X mode user sessions at the
same time on the same OPC. In fact, the system limits any combination of
character-mode terminal (CMT) and X mode sessions to a total of four.
Therefore, if four X mode user sessions are running on an OPC, no CMT user
sessions can be started.

Response time performance decreases significantly with four simultaneous X
mode user sessions on the same OPC. This is due to full CPU usage and
shortage in available memory swap space.

With four X mode user sessions running, 4 to 8 more tools (depending on the
tools started) can run over all sessions before the OPC runs out of memory
swap space.

With three X mode user sessions running, 10 to 14 more tools (depending on
the tools started) can run over all sessions before the OPC runs out of memory
swap space.

With two X mode user sessions running, 16 to 20 more tools (over and above
the number of tools that are started automatically) can run over all sessions
before the OPC runs out of memory swap space.

The recommendation is to run a maximum of one X mode user session at any
time on the OPC in order to have a sufficient amount of available memory
swap space and to achieve reasonable execution and response times.
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Procedure 5-1
Initializing the OPC Ethernet port

For the OPC to recognize and support communications with a Nortel
Networks’ Network Manager or an X terminal using the Ethernet port on the
OPC faceplate, the OPC Ethernet port must be initialized. Use this procedure
to initialize the OPC Ethernet port so that it can communicate with a Network
Manager or an X terminal.

Note: The Nortel Networks’ Network Manager is a software package
designed to run on a workstation. For more information on the Network
Manager, seeNetwork Manager User Guide, 323-4001-050.

Requirements
To complete this procedure, you must:

• make sure the OPC module is installed and started. Consult the workstation
hardware documentation to determine the applicable cabling option

• obtain the root password to access the OPC. This should be the OPC you
want to initialize

• obtain the following identifiers for initializing the OPC to be initialized:

— the OPC node name (for example: OPCM001P)

— the OPC Internet Protocol (IP) address (for example: 47.32.130.222)

— the OPC IP netmask (for example: 255.255.255.0)

• read the command conventions inOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning,
Volume 4A

Note:Up to eight characters are allowed for the SYSTEM_NAME variable
in the /etc/rc file. X terminal installation fails if this limit is exceeded.

—continued—



5-16 OPC Ethernet port configuration and connections

AccessNode Vol 3B 323-3001-220 Issue 2.0

Procedure 5-1 (continued)
Initializing the OPC Ethernet port

Action

Step Action

1 Log in to the OPC by entering the root userID and password at the login
prompt on a character-mode terminal (CMT).

The UNIX shell opc> prompt is displayed.

Obtaining the OPC IP address

2 Enter the following to change the UNIX directory:

cd /etc

The UNIX shell opc> prompt is displayed.

3 Enter the following to find the internet address and official hostname of the
OPC. The IP address and host name is used in later steps; therefore you may
want to write down this information.

cat hosts

The following is displayed

# The form for each entry is:
# <internet address> <official hostname> <aliases>
#
# For example:
# 192.1.2.34 hpfcrm loghost
#
# See the hosts(4) manual page for more information.
# Note:The entries cannot be preceded by a space.
# The format described in this file is the correct format.
# The original Berkeley manual page contains an error in
# the format description.
#
# 127.1.1.1. local host loopback
# 47.32.130.222 batpp222

Note: The internet address and official hostname of the OPC appear on the
last line of the above example.

—continued—
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Procedure 5-1 (continued)
Initializing the OPC Ethernet port

Step Action

Starting the Ethernet administration script

4 Start the Ethernet administration script by entering:

/iws/lan/ether_admin ↵
The Ethernet port command list is displayed:

1. Initialize and enable the Ethernet port

2. Ethernet port control (enable/disable)

3. X terminals configuration

4. Help

5. Quit

Select one of the above commands [1-5]:

5 The Ethernet port must be initialized before it can be enabled or disabled.
Select the Ethernet port initialization command by entering:

1 ↵
A message describing the port initialization requirements is displayed,
followed by a node name prompt:

Enter the nodename:

Enter the node name assigned to the OPC.

The node name can be up to a maximum of eight alphanumeric characters.
An example of node name is “OPCM001P”.

Refer to OPC User Interface Description, 323-3001-301, in Operations,
Administration, and Provisioning, Volume 4A, for information on obtaining the
node name assigned to the OPC.

6 Press the Return key (↵ ).

The nodename is checked. If the node name is not in the correct format an
error message is displayed, followed by another node name prompt. If the
node name prompt reappears, go to step 5.

Once you enter an acceptable node name, an IP address prompt is displayed:

Enter the IP address:

7 Enter the unique IP address number assigned to the OPC as found in step 3.

The IP address consists of four numbers, each separated by a period. Each
number must be greater than or equal to 0, and less than or equal to 255. The
IP address in the example is in step 3 on page 5-16:

47.32.130.222

8 Press the Return key (↵ ).

—continued—
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Procedure 5-1 (continued)
Initializing the OPC Ethernet port

Step Action

The IP address is checked. If the IP address is not in the correct format, or it
is reserved, or already assigned to another OPC, an error message is
displayed, followed by another IP address prompt. If the IP address prompt
re-appears, go to step 7.

Once you enter an acceptable IP address, the netmask prompt is displayed:

Enter the netmask [default 255.255.255.0]:

9 Enter the netmask number assigned to the OPC.

The default netmask value is 255.255.255.0. You can accept this value by
pressing the Return key. If desired, you can enter a new netmask number
using the same criteria as the IP address.

10 Press the Return key (↵ ).

The netmask is checked. If the netmask is not in the correct format, an error
message is displayed followed by another netmask prompt. If the netmask
prompt re-appears, go to step 9.

Once you enter an acceptable netmask number, a summary of the Ethernet
port initialization values appears, followed by a request to continue with the
initialization process:

Initializing Ethernet to:
name: ‘OPCM001P’

address: ‘47.32.130.222’
netmask: ‘255.255.255.0’

Do you wish to continue? [yes;no]:

11 Check the initialization values in the summary and verify that they are correct.

12 Continue the Ethernet port initialization process by entering:

yes ↵
The Ethernet port command list is displayed.

1. Initialize and enable the Ethernet port

2. Ethernet port control (enable/disable)

3. X terminals configuration

4. Help

5. Quit

Select one of the above commands [1-5]:

—continued—

If you want to Then go to

continue the Ethernet port initialization step 12

discontinue the Ethernet port initialization step 15
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Procedure 5-1 (continued)
Initializing the OPC Ethernet port

Step Action

13 Complete the Ethernet port initialization process by entering:

1 ↵
The Ethernet port is now initialized.

14 Reboot the OPC. If you do not know how to do this, refer to OPC User
Interface Description, 323-3001-301, in Operations, Administration, and
Provisioning, Volume 4A.

The OPC is now ready to communicate with the Network Manager or X
terminal.

15 Discontinue the Ethernet port initialization process by entering:

no ↵
The Ethernet port command list appears.

If you want to re-execute the Ethernet port initialization process, go to step 3.

16 Quit the Ethernet administration script by entering:

5 ↵
The UNIX shell opc> prompt is displayed.

—end—
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Procedure 5-2
Controlling the OPC Ethernet port

Use this procedure to control, that is, enable or disable, the OPC Ethernet port.
The OPC can communicate with the Network Manager or X terminal only
when the Ethernet port is enabled.

Requirements
To complete this procedure, you must:

• obtain the root password to access the OPC whose Ethernet port is to be
enabled and disabled

• make sure the OPC Ethernet port is initialized. If you attempt to control the
Ethernet port before initializing it, a message appears indicating the port
must be initialized before it can be controlled. If the Ethernet port is not
initialized, see Procedure 5-1, “Initializing the OPC Ethernet port” on
page 5-15.

• read the command conventions inOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning,
Volume 4A

Action

Step Action

1 Log in to the OPC by entering the root userID and password at the login
prompt.

The UNIX shell opc> prompt is displayed:

2 Start the Ethernet administration script by entering:

/iws/lan/ether_admin ↵
The Ethernet port command list is displayed.

1. Initialize and enable the Ethernet port

2. Ethernet port control (enable/disable)

3. X terminals configuration

4. Help

5. Quit

Select one of the above commands [1-5]:

Note: The Ethernet port must be initialized before it can be controlled. If you
do not know how to do this, see Procedure 5-1 on page 5-15.

—continued—
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Procedure 5-2 (continued)
Controlling the OPC Ethernet port

Step Action

3 Select the Ethernet port control command by entering:

2 ↵
A message that identifies the Ethernet port control values is displayed,
followed by a prompt for the new Ethernet port status:

You will be prompted for the following information:
new Ethernet port status: enabled or disabled

Type 'abort' at the prompt to terminate the command.

Enter new Ethernet port status [e - enable,
d - disable]

4 The Ethernet port must be enabled to allow the OPC to communicate with the
Network Manager or X terminal. When the Ethernet port is disabled, the OPC
is disconnected from the network.

5 Enable the Ethernet port by entering:

e ↵
The following message is displayed:

Warning: Unable to add default route in the routing table.
Changes to the routing table will only take effect after
the OPC is rebooted with the OPC shutdown tool.

Refer to OPC User Interface Description, 323-3001-301, in Operations,
Administration, and Provisioning, Volume 4A, for information on rebooting the
OPC.

The Ethernet port is now enabled. The OPC is now ready to communicate
with the Network Manager or X terminal.

Note: If the Ethernet port is already enabled, this step has no effect.

Go to step 10.

6 Disable the Ethernet port by entering:

d ↵
The following warning message is displayed:

Warning!

Disabling the Ethernet port will cause loss of network
connectivity.

Do you wish to continue? [yes, no]:

—continued—

If you want to Then go to

enable the Ethernet port step 5

disable the Ethernet port step 6
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Procedure 5-2 (continued)
Controlling the OPC Ethernet port

Step Action

7 If you disable the Ethernet port, the OPC will not be able to communicate with
the Network Manager or X terminal.

8 Continue and disable the Ethernet port by entering:

yes ↵
The Ethernet port command list is displayed:

1. Initialize and enable the Ethernet port

2. Ethernet port control (enable/disable)

3. X terminals configuration

4. Help

5. Quit

Select one of the above commands [1-5]:

The Ethernet port is disabled, and the OPC will not be able to communicate
with the Network Manager or X terminal.

Go to step 10.

9 Terminate the Ethernet port control procedure without disabling the port by
entering:

no ↵
The Ethernet port command list is displayed:

1. Initialize and enable the Ethernet port

2. Ethernet port control (enable/disable)

3. X terminals configuration

4. Help

5. Quit

Select one of the above commands [1-5]:

10 Quit the Ethernet administration script by entering:

5 ↵
The UNIX shell opc> prompt is displayed.

—end—

If you want to Then go to

continue and disable the port step 8

leave the port enabled and quit the procedure step 9
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Procedure 5-3
Connecting the OPC to network equipment

Use this procedure to connect the operations controller (OPC) to an X
terminal, a local area network (LAN), or a Nortel Networks’ Network
Manager. In this procedure, the term “network equipment” is used to refer to
an X terminal, a LAN, or the Network Manager.

Requirements
To complete this procedure, you must:

• familiarize yourself with the information in the “Cabling options” section
starting on page 5-8. This procedure is only relevant for network
equipment and installations that are addressed in that section.

• use the information provided in the “Cabling options” section starting on
page 5-8 to identify the correct cable for your network equipment and
installation

• have the appropriate cable

• have the required tools for tightening the cable connectors and mounting
hardware

Action

Step Action

1 Connect the Dupont Latch-n-Lock end of the cable to the connector located
on the faceplate of the OPC, under the tape drive cover.

2 Route the cable to the top of the shelf and secure it using the Pozidrive screws
provided with the cable.

3 Route the cable along the frame and secure it with cable ties.

4 Run the cable either underneath the floor or on top of the cable troughs to the
location of the X terminal or to the Ethernet LAN’s hub connector.

—continued—

CAUTION
Risk of fiber damage
Any cabling should be done with the utmost care to avoid
damage to the fibers.
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Procedure 5-3 (continued)
Connecting the OPC to network equipment

Step Action

5 Consult the documentation for the network equipment to identify the location
of the equipment’s Ethernet port.

6 Connect the RJ45 connector of the cable to the appropriate port on the
network equipment.

Go to step 9.

7 Connect the RJ45 connector of the cable to the media access unit (MAU).

8 Plug the media access unit (MAU) in to the appropriate port on the network
equipment.

9 Make sure that all connectors are fully and firmly seated.

Pin assignments for the cables are shown in “Cabling options” on page 5-8.

—end—

If the network equipment Then go to

has a twisted pair port step 6

has a DB-15 port step 7



OPC Ethernet port configuration and connections 5-25

AccessNode Optional Commissioning Procedures 323-3001-220 Issue 2.0

Procedure 5-4
Establishing a Telnet session between an X terminal
and the OPC

Use this procedure to establish a Telnet session with the operations controller
(OPC).

Requirements
To complete this procedure, you must:

• have the Internet Protocol (IP) address for the OPC

• obtain the root password that permits access to the OPC

• make sure the Ethernet port is initialized and enabled

• read the command conventions inOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning,
Volume 4A

Action

Step Action

1 From the vendor’s documentation for the X terminal you are using, determine
how to start a Telnet session. When instructed to do so, enter the IP address
for the OPC.

The UNIX shell opc> prompt is displayed.

2 Log in to the OPC as the root user.

The TERM = (vt100) prompt is displayed.

3 Press the Return key (↵ ) to select the VT100 terminal mode.

The UNIX shell opc> prompt is displayed.

4 The X terminal is now connected to the OPC and is emulating a VT100
terminal in a UNIX session.

—end—

If you want to Then

logout enter logout after the UNIX shell opc> prompt

continue enter the desired command after the UNIX shell
opc> prompt
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Procedure 5-5
Adding, changing, or deleting an NCD19 configuration
file

Because the Network Computing Device NCD19 X terminal does not retain
certain X terminal display manager (XDMCP) parameters following a reboot,
the operations controller (OPC) must provide a means for storing these
parameters. A program on the OPC named ether_admin enables you to create
an NCD19 configuration file. The OPC uses this configuration file to
reestablish the NCD19 parameters after a reboot.

Use this procedure to add, change, or delete an NCD19 X terminal
configuration file on the OPC. The procedure for changing a file is the same as
for adding a file.

Requirements
Before starting this procedure, you must have the following material and
information:

• the software version of the NCD19 X terminal (NCDware v.2 or v.3)

• the Internet Protocol (IP) address of the NCD19 X terminal

• the NCD19 booting source, either its PROM or the IP address of the
bootserver

• the system’s root userID and password

• the command conventions described inOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning,
Volume 4A

Action

Step Action

1 Log in to the OPC by entering the root userID and password at the login
prompt on a character-mode terminal (CMT) or through a Telnet session from
an X terminal.

The UNIX shell opc> prompt is displayed.

2 At the opc> prompt, start the Ethernet administration (ether_admin) program
by entering:

/iws/lan/ether_admin ↵
The Ethernet port command list is displayed as shown on the following page.

—continued—
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Procedure 5-5 (continued)
Adding, changing, or deleting an NCD19 configuration file

Step Action

1. Initialize and enable the Ethernet port

2. Ethernet port control (enable/disable)

3. X terminals configuration

4. Help

5. Quit

Select one of the above commands [1-5]:

3 Select the X terminals configuration command by entering the following:

3 ↵
A message describing the X terminals configuration option is displayed. The
system then prompts you to select the desired operation:

Enter the operation to perform [a - add , d - delete]:

Note: The same procedure is used to add or change the configuration file.

4 To add or change a configuration file enter the following:

a ↵
A message describing the requirements for adding an X terminal
configuration file is displayed. The system then prompts you to enter an
NCD19 version number:

Enter the NCD19 X terminal software version number [2-3]:

5 Use the following table to determine the correct NCD19 X terminal software
entry to make at the prompt:

6 The system then prompts you to enter the IP address of the X terminal:

Enter the X terminal IP address [format must be n.n.n.n,
where n is between 0 and 255]:

Note: IP addresses are unique and assigned by the manufacturer. The IP
address consists of four numbers each separated by a period. Each number
falls in the range of 0 to 255, for example, 99.205.1.93.

7 The system prompts you to enter the Boot Server IP address:

—continued—

If you want to Then go to

add or change the configuration file step 4

delete an entry in the configuration file step 13

If the NCD19 software version number is Then enter

v.2 2

v.3 3
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Procedure 5-5 (continued)
Adding, changing, or deleting an NCD19 configuration file

Step Action

Enter the Boot Server IP address [format must be n.n.n.n,
where n is between 0 and 255; press Return to Boot From
PROM]:

8 If the X terminal is equipped with an X Server PROM, press the Return
key (↵ ).

Go to step 10.

9 If the X terminal is not equipped with an X server PROM, enter the IP address
of the Boot Server at the prompt and press Return (↵ ).

Go to step 10.

10 Continue as required:

11 If you are changing an existing file, the following message is displayed:

<file name> already exists. Replace it (y or n)?

Enter the following:

y ↵
The following message then is displayed.

NCD19 configuration file <file name> added (replaced).
Press any key to continue.

Go to step 15.

12 If you are adding a new file, the following message is displayed:

NCD19 configuration file <file name> added (replaced).
Press any key to continue.

Go to step 15.

13 To delete a configuration file, enter the following:

d ↵
A message describing the requirements for deleting an X terminal
configuration file is displayed. The system then prompts you to enter the IP
address of the X terminal.

—continued—

If the X terminal Then go to

is equipped with an X Server PROM step 8

is not equipped with an X Server PROM and so requires
communications with a Boot Server in order to boot

step 9

If you are Then go to

changing an existing file step 11

adding a new file step 12
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Procedure 5-5 (continued)
Adding, changing, or deleting an NCD19 configuration file

Step Action

Enter the X terminal IP address [format must be n.n.n.n,
where n is between 0 and 255]:

IP addresses are unique and assigned by the manufacturer. The IP address
consists of four numbers, each separated by a period. Each number falls in
the range of 0 to 255, for example, 99.205.1.93.

14 Enter the IP address of the X terminal at the prompt.

A message is displayed showing the IP address of the Xterm whose
configuration file is being deleted. A confirmation is required:

Enter the following:

y ↵
A message is displayed indicating that an NCD19 configuration file is deleted:

NCD19 configuration file ‘file number’ removed.

Press any key to continue.

15 Press the Return key (↵ ).

The Ethernet port command list is displayed:

1. Initialize and enable the Ethernet port

2. Ethernet port control (enable/disable)

3. X terminals configuration

4. Help

5. Quit

Select one of the above commands [1-5]:

16 Quit the Ethernet administration program by entering the following:

5 ↵
17 Log out of the session by entering:

logout  ↵
You now load the NCD19 data from the OPC to the NCD19 X terminal.

—end—

If the software version
number is

Then continue with

v.2 Procedure 5-6 on page 5-30

v.3 Procedure 5-7 on page 5-32
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Procedure 5-6
Loading the NCD19 configuration data from the OPC
to an NCD19 X terminal running NCDware v.2

Use this procedure to load the Network Computing Devices NCD19 X
terminal with the configuration parameters that were created using the
ether_admin program. This procedure applies to any version v.2 of NCDware.

The HP 700/RX X terminal and the Tektronix XP18 X terminal are not covered
in this procedure because these terminals are self-booting and do not need
configuration data from the operations controller (OPC). No configuration
loading procedure is required for these terminals.

After you successfully complete this procedure, a graphical OPC login dialog
is displayed on the NCD19. Thereafter, the OPC login dialog is displayed each
time you power on or reset the NCD19.

Requirements
To complete this procedure, you must:.

• review the NCD19 user manual to become familiar with the configuration
screens and capabilities

• obtain the internet protocol (IP) address of the OPC

• verify that the NCDware version is in the v.2 family

• read the command conventions inOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning,
Volume 4A

Action

Step Action

1 Setup the X terminal according to the requirements provided in the section “X
terminal setup requirements” on page 5-5.

2 From the Main Menu, select Network Parameters in the Configuration Menu
group.

The Network Parameters window is displayed.
—continued—
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Procedure 5-6 (continued)
Loading the NCD19 configuration data from the OPC to an NCD19 X terminal running NCDware v.2

Step Action

3 Set the Remote Configuration parameter field to Yes.

To change a parameter, click on Select in the parameter's value field. The
next value is displayed in the field. Continue selecting the field until the value
you want is displayed.

4 Move the pointer to the Configuration Server field and enter the IP Address
of the OPC.

5 Return to the Main window by selecting the Main Menu button in the Network
Parameters window.

6 Select the Save Power-On Values button in the Main Menu window.

7 Select the Reset Server button in the Main Menu window.

After you confirm the reset request, the NCD19 executes its reset procedure.
After some progress messages, a grey pattern is displayed on the screen.

After a few seconds, an OPC login dialog is displayed.

The NCD19 is now fully configured and ready to use.

—end—
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Procedure 5-7
Loading the NCD19 configuration data from the OPC
to an NCD19 X terminal running NCDware v.3

Use this procedure to load the Network Computing Devices NCD19 X
terminal with the configuration parameters that were created using the
ether_admin program. This procedure applies to any version v.3 of NCDware.

The HP 700/RX X terminal and the Tektronix XP18 X terminal are not covered
in this procedure because these terminals are self-booting and do not need
configuration data from the operations controller (OPC). No configuration
loading procedure is required for these terminals.

After you successfully complete this procedure, a graphical OPC login dialog
is displayed on the NCD19. The OPC login dialog is displayed each time you
power on or reset the NCD19.

Requirements
To complete this procedure, you must:

• review the NCD19 user manual to become familiar with the configuration
screens and capabilities

• verify that the NCDware version is in the v.3 family

• read the command conventions inOPC User Interface Description,
323-3001-301, inOperations, Administration, and Provisioning,
Volume 4A

Action

Step Action

1 Setup the X terminal according to the requirements provided in the section,
“X terminal setup requirements” on page 5-5.

2 From the NCD User Services: Console window, pull down the Console menu
and select the Reboot command.

The Reboot dialog is displayed.

3 Select the OK button.

The NCD19 executes its reboot procedure. After some progress messages,
a grey pattern is displayed on the screen.

After a few seconds, an OPC login dialog is displayed.

4 The NCD19 is now fully configured and ready to use.

—end—
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Procedure 5-8
Reconfiguring X terminals following an OPC
upgrade

Use this procedure to get the operations controller (OPC) login banner on an
X terminal following an OPC software upgrade. The procedure applies to X
terminals that are already connected to the OPC prior to the upgrade. The
instructions indicate the parameters to set up, but do not provide
equipment-specific details.

Action

Step Action

1 Determine the type of X terminal:

2 Set the X terminal for remote configuration.

3 For the remote configuration host, specify the IP address of the OPC.

4 For the remote configuration file access, specify TFTP.

Note: The term “remote configuration” is generic. Each manufacturer has
their own term. Contact the manufacturer’s representative if the X terminal
documentation does not use the terminal’s remote configuration terminology.

5 Enable XDMCP with Direct Access.

6 Set the XDMCP host to the IP address of the OPC.

7 Determine the type of X terminal:

8 Under Host File Access, set Primary XP File Root to “/usr/lib/X11/XP” (quotes
not included).

9 Save the parameter settings to non-volatile random access memory
(NVRAM).

Continue with step 11.

10 Perform Procedure 5-5 on page 5-26 to add a configuration file.

11 If not already done, reboot the terminal.

The OPC login banner is displayed. You can now log in to the OPC.
—end—

If the X terminal is Then go to

an NCD19 step 10

a 700/RX or an XP18 step 2

If the X terminal is Then go to

a 700/RX step 9

an XP18 step 8
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